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Bl Introduction

Thank you very much for purchasing the SV-NET Controller.
The SV-NET Controller is a motion controller that is compliant with the Tamagawa Seiki original motion network (SV-NET).
You can architect a compact motion control system by using this product in combination with our SV-NET drivers.

This manual describes how to use the SV Programmer (a programming tool designed specifically for the SV-NET
Controller). The SV Programmer helps you create your own servo systems. Make sure you thoroughly understand the use

and functions of the SV Programmer as well as the techniques behind the product before using it for control of your system.

Hl Abbreviations

This manual uses the abbreviations shown in the following table:

Abbreviation Meaning
SV-NET controller or controller SV-NET Controller
SV-NET driver or driver SV-NET driver
Servo motor or motor AC Servo motor
Program SV-NET Controller motion program

B Manual Number of this Manual

Manual number: MNL0O00318Y00



B Revision History

Version Date Item Description Page
1.0 2007/11/21 New
Safet_y The item “Technical Personnel Dispatching Service” is added. Safet_y
Precautions Precautions
Main Form Description of the status bar is changed. Page 4
Controller Setup | Description of network configuration is added. Page 42
JOG Operation |Description of stop operation from the Tool Pane is deleted. Page 51
Description of the File Pane is added. Page 57
Description of the array variable list is added. Page 66
Descriptions of the Jog Pane and the DIO Pane are added to | Pages 76 and
the Subpane. 77
Program Grid  [Description of starting status monitoring from the Supervision
Pane, Monitor Pane, or Task Pane of the Subpane with the Pages 73 to 75
[Start] button is deleted.
2.0 2008/9/2 “Debug” has been changed to “Debug.” Page 59
A list of monitor variables is added. Page 82
Descriptions of the oscilloscope, X-Y representation, and file Page 86
) are added to the Tool Pane. 9
Servo Monitor
Description of a pulldown menu is added to the description of | Pages 89 and
graphical display of information. 20
Description of setting the Array Variable List window is added
o L . Page 99
Utilit as a part of description of program grid window setting.
ilities
Description of label definition is added. Pages1 (1)23 and
Description of file handling items is added to the program grid. Pages1 (1)25 and
Menu ltems of forward rotation, reverse rotation, and stop operation | Pages 114 and
Configuration | are deleted from JOG Operation. 121
Descriptions of the oscilloscope and X-Y representation are Pages 116 and
added to the Servo Monitor. 122







B Safety Precautions

® Warranty

O Period of Warranty
This warranty covers repair or replacement of the product only if the customer contacts us or returns the defective
product within one year after shipment.
O Scope of Warranty
Please note that we are not liable for any quality deterioration of the product resulting from use or storage that differs in
the following manner from that described in this manual, even if the pertinent product is still under warranty:
e The product is used under any condition, in any environment, or by any method other than those described in the
product specifications, manuals, or others.
e The product is modified or repaired by any person other than our service engineers.
e The product is used in a way not originally intended.
e The problem in question could not be predicted with the technology available at the time the product was shipped.
O Limitations of Warranty
* We are not liable for any damage to others arising from our products.

e We are not liable for any results caused by programs prepared by any person other than our representatives.

® Conditions of Use

O This product is designed and manufactured for general industrial applications. It cannot be used with equipment and
systems operated under conditions where there is a risk to life.

O This product is not intended for use in applications which require extremely high reliability.
If this product is used in any of the applications listed below, consult specifications, manuals, or other documents to
narrow your questions and then contact our sales representatives.
Be sure to take necessary safety measures, including implementation of safety circuits to minimize danger in case of a
failure.
o Atomic energy control equipment, spaceships, trains, airplanes, vehicle equipment, medical equipment, safety devices,

and incinerators
o Systems, machines, and equipment that may endanger human life or property
o Facilities that require high reliability such as gas, water, and power utilities, and equipment used for 24-hour continuous
operation

e Outdoor use or use under conditions not described in the manuals or other documents
o Other applications comparable to the above that require high reliability

O We make continuous efforts to improve the quality and reliability of this product. However, there is always a possibility
that this product may malfunction.
For the use of this product, we recommend you take numerous safety measures to prevent a malfunction of this product
from propagating or escalating.

O Program samples and application examples shown in the manuals and other documents are for reference only.
Please make sure of the safety and functions of the systems, machines, and equipment in which this product is to be

used before use.



® Changes to Specifications

The specifications, manuals, data sheets, and other documents for this product may be changed as needed for
improvement of performance, expansion of specifications, or addition of accessories. For the latest technical data, please

contact our sales representatives.

® Upgrading

The software for the main unit of this product may be upgraded for improvement of performance or expansion of
specifications.
Please check that you have the latest software version installed before use. If an update is required, consult our sales

representative.

® Service Limitations

The price of this product does not include fees for dispatching technical personnel or other services.

Consult our sales representative for details if necessary.

® Technical Personnel Dispatching Service

We offer the technical personnel dispatching service for a modest fee to help customers to launch their equipment.

This service covers:

» Adjusting servo gains
» Preparing programs to operate the SV-NET controller
e Explaining how to adjust servo gains

» Explaining how to handle the SV Programmer

It will take some time to initially start equipment or implement a new system.
It is particularly recommended to use our technical personnel dispatching service if you want to implement a new system or
change an existing system.

If you have any questions about service fees or details of the service, please contact our sales representative.
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Outline of This Software

What Is the SV Programmer?

The SV Programmer is PC application software that is connected to the SV-NET controller through USB.

The SV Programmer has the following functions:
e Function to handle the parameters of the SV-NET driver
e Function to handle parameters of the SV-NET controller
¢ Motor test-run function
e Programming function

e Various monitoring functions

—1-
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Software Operating Environment

The following is a description of this software:

PC PC/AT-compatible machine
Supported OS Windows2000/XP/Vista
Required memory 256 MB or more
Hard disk 500 MB or more
Communication USB
Required software Microsoft .NET Framework 2.0

* Notes:
1. If Microsoft .NET Framework 2.0 is not installed on your PC, it is automatically installed by the installer.
If you do not want the automatic installation, download Microsoft .NET Framework 2.0 from the Microsoft Web site for

installation on your PC.

2. If this application is executed on Windows Vista, do not use the Windows Aero function.
— Otherwise, some functions including the monitor function may not provide proper display depending in the environment of
your PC.

*Note: For the Windows Aero function, refer to the Windows Vista manual.

—2_
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Starting the SV Programmer

The following is a description of how to start this software:

Operation
1. Select [SV-NET Controller Software]-[SV Programmer] from the Start menu.

2. A splash window is displayed.

3. “ON LINE” is displayed at USB Status in the status bar.

4. A project file selection box is displayed.

5. This software is now usable.

* Note:
If “ON LINE” is displayed at USB Status in the status bar, the SV-NET controller is not connected.

In this status, some functions cannot be used.

—-3-

Copyright© 2008 Tamagawa Seiki CO.,LTD



When this software is started, the main toolbar and the status bar are displayed in the initial window. When you click a

button in the main toolbar, the associated window is displayed in the form display area.

||Configuration of the Initial Window

Main Toolbar

Ga———

Fikl  Hebdh

i v gy B el Svegy il b st [ | et (il

el L

S¥Pgesnmmr Propct Flis

00

Co
ﬂcn

Forrm Display Area

Doee Fromt Row Frapci

Project File

Selection Box

Status Bar

Main Toolbar

When you click a button in the main toolbar, the associated form window is started.

ﬂ Device Setup % Cantraller Setup ﬂ Jog Operation E Frogram Grid 2% Servo Monitor o [tility
[Device Setup] button

Starts [Device Setup], which allows you to reference and set parameters of the SV-NET driver.

[Controller Setup] button
—4-
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Starts [Controller Setup], which allows you to reference and set parameters of the SV-NET controller.

[Jog Operation] button

Starts [Jog Operation], which performs a test run of the servo motor.

[Program Grid] button

Starts [Program Grid], which creates, edits, and executes a program.

[Servo Monitor] button

Starts [Servo Monitor], which monitors the feedback data of the SV-NET driver and the status of the SV-NET controller.

[Utility] button

Starts [Utility], which makes display settings and operates special functions of each window.

Form Display Area

The form display area is a client area where a form window is displayed.

When you click a button in the main toolbar, the associated form is displayed.

-5-
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Status Bar

The status bar displays the execution status of this software as the status.

TTEH Controller Civerride Task Debug

Btatus ersion Btatus Btatus
| — OMLIME SWCC=T VERLOOL VR 100% READY STOP HORMAL

Controller Ready

Tyne Alarm

[USB Status]
Displays the connection status between the PC and the SV-NET controller.
When the two are being connected, “ON LINE” is displayed on a green background.

When the two are not connected, “OFF LINE” is displayed on a gray background.

[Controller Type]

Displays the controller type.

[Controller Version]

Displays the controller version.

[Override]

Displays the present speed override value.

[Ready Alarm Status]
Displays “Ready” on a light blue background if no alarm exists while the PC and the SV-NET controller are being
connected.

Blinks “Alarm” on a pink background if an alarm exists.

[Task Status]

Displays “RUN” on a yellow background when a task is being executed.

[Debug Status]

Displays “NORMAL” if a task is executed in the normal mode; displays “DEBUG” if a task is executed in the debug mode.

—6-
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[Progress Bar]

Indicates the progress of communication with the SV-NET controller.
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Project File Selection Box

Selects whether to create a new project file or to read a saved project file. In the project file, the window configurations

changed by the user and the folders containing the program files are recorded.

* You can operate each function of the main toolbar with no project file selected.

You do not necessarily create a project file.

8-
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Device Setup

You can reference and set parameters of the SV-NET driver.

Device Setup Functions

e Function to obtain SV-NET controller connection information and parameters
1. Searches for the drivers connected to the SV-NET controller.
2. Obtains the parameters of only the specified SV-NET driver.

3. Obtains the parameters of the SV-NET drivers of all axes at a time.

e Function to manage SV-NET driver parameter files
1. Obtains parameters from a text file.
2. Saves parameters in a text file.

3. Saves parameters in the SV-NET driver.

e Switch Data Type Display function

1. Displays parameter values in decimal or hexadecimal notation.

e Switch Parameter Display function
1. Displays the parameters in a list.

2. Displays parameters by categories.

¢ Print function
1. Prints the parameter list on the printer.

2. Displays the preview of a print image.

—9-
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|Description of the Device Setup Window

The configuration of the Device Setup window is as follows:

Tool Fane

ParameterF‘aE:}_/

A Sy HET Dnvice Gafup
=

g B aat -]
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[Tool

Pane]

The following table describes each tool button used for device setup.

Group Button Description of function
Search Met Starts communication with the SV-NET controller and displays the
=]
BEIED number of presently connected axes.
Obtains the parameters from all the connected SV-NET drivers.
E Read All
. Obtains the parameters from the selected SV-NET driver.
_4 Read One
i Writes all the parameters to the selected SV-NET driver. *Note:
S Write One
File Reads a parameter file.
= ©Open
Saves a parameter file.
sl Save
i Prints a parameter list on the printer.
= Print
) Displays the print image of parameters.
&, Preview
. Saves parameters in the flash memory of the SV-NET driver.
52 Flash
Data Displays the parameter values in decimal or hexadecimal notation.
# DEGC
{3 HEX
View Displays all the parameters in a list.
=1 Al

:= Gatesory

Displays parameters by categories.

* Note:

When you click the [Write One] button, all parameters with a rewritable data ID are changed.

Make sure that all the parameters displayed in the list are correct before clicking the [Write One] button.

-> List of All Parameters Including Writable Parameters

-11-
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[Parameter Pane]

This section describes the contents of the parameter pane.

[Net List]

This page displays the product information of the presently connected SV-NET driver.

When you click a specific “Device (No.) ” the detailed data of that SV-NET driver is displayed.

MAC-ID 7 EAC-ID - 8
Met List | MAL-ID | 1 MAL-ID @« 2 | R | M AG-TD MAC-ID : &
Davice 1 | Device 4
MAD-ID | Dewioe | Product Fe vising Heral Dewice | Product | Hewsio
1 ] 1 | 0 | 48 1054 1| 80 hecl
Device 2 | Deviee B
A ] Dewice | Froduci Frewaninn fieriad Dewice | Prodeci | Fim winic
2 | 1 | 8410 493 1055 1 2410 453
Device 3 | Device 6
AT I Dia wicem l Produch P vivion | Bariad Dawica ] Produsi l Fimwisid
a3 1 | adie | a3 1086 1 | sain | dba
< >
Outline of Driver Product Information
<MAC-ID>
MAC-ID number of the SV-NET driver
<Device>
Device number of the device
<Product>
Product model of the SV-NET driver
<Revision>
Software version of the SV-NET driver
< Serial>
Serial number of the SV-NET driver
—-12 -
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[MAC-ID: *] Tab Page [List Display]

This page displays the parameter list for each MAC-ID number set in the SV-NET driver.

MAC-ID - 7 MAC-TD -
MHel List MAC-TD - 1 | MAC-ID : 2 MAC-ID - 3 MAC-ID - 4 BAC-TD - & MAC=ID - 6
Data 00 Diata Nama Diata Vs Data Type il gl i "‘

r B ocvice Gode 1 s 2 NG oK
? Product Gode fl I z L] 0K
3 Hewizwn Eite] i 2 NG oK
4 Sarial Humber 1064 r 4 NG 0K
-1 MAC-I0 Dedaull a r 1 L] 8 K
] Bansd Rate 4 r 1 i1 4 0K
1 Hesarve o r 1 5] MG
B Reserve o FF z HG MG
9 Hesarve 1 r 2 NG MG
10 Reserve o r 2 NG MG
LA Regarve o r z NG MG
12 Heserve 1 r 2 HG MG
13 Reserve 1 I z NG MG
4 Heserve 1 = 2 NG MG
16 Reserve B0 [ z Wi MG
16 Parameter Insl ] " 1 0K 5]
17 Parameter Save ] [ 1 0K MG w

Outline of Parameters
<Data ID>

Displays the parameter ID numbers.

<Data Name>

Displays the parameter names.

<Data Value>

Displays the parameter set values.

<Data Type>
Switches the notation of parameter values between decimal and hexadecimal.

(Unchecked: Decimal, Checked: Hexadecimal)

<Data Length>

Displays the length of each parameter in bytes.

<Write Enable >

“y”

“O” indicates that the parameter is rewritable; “x” indicates that the parameter is not rewritable.

<Save Enable>
“O” indicates that the parameter can be saved in the flash memory; “x” indicates that the parameter cannot be saved in the
flash memory.
—13-

Copyright© 2008 Tamagawa Seiki CO.,LTD



* Note:

The tab text on the [MAC-ID: *] Tab Page contains the MAC-ID numbers set in the SV-NET driver.
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List of All Parameters Including Writable Parameters

ID Parameter name

50 Kp1

51 Kv1

52 Ki1

53 LPF_f

54 NF_f

55 NF_d

56 Kcep1

57 Kci1

58 Phase-Advance Gain

59 Load Inertia

60 Kp2

61 Kv2

62 Ki2

70 Position Resolution_n

71 Position Resolution_m

72 Reference Direction

73 Position Feedback Select

74 Position Instruction Select

75 Velocity Instruction Select

76 Torque Instruction Select

77 InPosition Signal Range

78 Smoothing Function Select

79 Smoothing Time Constant

80 Gain Change Select

81 Gain Change Point_H

82 Gain Change Point_L

83 Soft Limit Select

84 Positive Position Limit

85 Negative Position Limit

86 Positive Current Limit

87 Negative Current Limit

88 Velocity Limit

90 Homing Type

91 Preset Value

92 Homing Start Direction
—15-—
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93 Homing Velocity

94 Creep Velocity

95 Bump Time

96 Bump Torque

100 Parameter IN-1

101 Parameter IN-2

102 Parameter IN-3

103 Parameter IN-4

104 Parameter IN-5

105 Parameter IN-6

110 Parameter OUT-1

111 Parameter OUT-2
118 Monitor1

119 Monitor2

120 Pulse Input Mode
121 Pulse Input Resolution_n
122 Pulse Input Resolution_m
130 Analog Velocity Scale
131 Analog Current Scale
140 Abs Mode

141 Servo Select

143 Servo Off Delay

145 Tuning-KV

146 Tuning-KI

147 Brake off Delay

148 Enable Off Time

200 Over Load

201 Over Velocity

202 Alarm Pulse1

203 Alarm Pulse2

204 Over Temp

206 Low Voltage

—-16 -
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[MAC-ID: *] Tab Page [Category Display]
This page displays the parameters by categories for each MAC-ID number set in the SV-NET driver.

BAC-ID . 6 HWAC-TN - 7 MAC-ID - B
Het List | A0~ 1 [ MAC-ID - 2 MAG-ID : 3 WAC-ID - 4 MAG-ID : B
SV-MET Driver Information | Servo Feaffack
| MAGID  Device Gode Product Gode | Revision  Serial Mumber | | Pasition  [NSRSHEEE. Guerent |
1 1 -Eabi] 493 1084 | L1} | ] 1
| [pulee] [epm 1 [000A]
Gartrol Mok Serva Gommrt | Serva Status
(0 Position Coreal ClSaroOn [ Accal Lima On W seroin [ Formed Lime
3 Vielocity Gonirol | Glear Mlerm ] Dirmotion Wik W Feveres Limit
Torgue i ==
= A TW“MH Tl Smoath Step [ Clear Potiwrnce B kFosition . Torgue Limit
L] o |uring = '
& N cateer | Haret Siop [ Position Resat . | B el Lisii
&
Command Daka | Profile Dats |
[ mpm 1 ' | [ pulae 1
[oiia ] | [ pm 1
ol | [Nirpmal
all | [rpms=]
&

[SV-NET Driver Information]

Displays the product information of the driver.

SVY-MNET Driver Information

MACG-ID Device Gode | Product Gode | Revision |Serial Humber
1 1 2410 493 1054

<MAC-ID>
Displays the MAC-ID of the driver. If the rotary DIP switch is set to any of the positions other than [0], the set value of the

switch is displayed.

< Device Code>

Displays the type of the connected device.

<Product Code>

Displays the model of the connected device.

<Revison>

Displays the revision of the connected device.
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< Serial Number>

Displays the serial number of the connected device.

[Servo FeedBack]

Displays the feedback information of the driver.

bervo FeedBack
Position Current
1] -18 1
[ pulze ] [ rpm 1 [001A ]

< Position>

Displays the present position of the driver (unit: pulse).

<Velocity >

Displays the present speed of the driver (unit: rpm).

<Current>

Displays the present electric current of the driver (unit: 0.01 A).

[Control Mode]

Changes the control mode for the driver.

Control Mode

Fozition Control
Welocity Control
Torque Gaontrol
Auto Tuning

Mo Select

©®@0000

< Position Control>

Sets the driver to the position control mode.

<Velocity Control>

Sets the driver to the speed control mode.

<Torque Control>

Sets the driver to the electric current control mode.

—-18 -
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<Auto Tuning>
Sets the driver to the auto-tuning mode.

If settings are changed in the Servo ON status, tuning starts automatically.

<No Select>

Sets the driver to a mode other than the above.

—-19—
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[Servo Command]

You can set commands to the driver by clicking the checkboxes.

Servo Command

L] Serva On [ fccel Limit On
O Clear Alarm [ Direction

[] Smooth Stop [] Glear P-error
[] Hard Stop [] Position Rezet

<Servo On>

Turns the servo ON.

<Clear Alarm>

Clears the driver alarm.

<Smooth Stop>

Decelerates and stops the motor rotation.

<Hard Stop>

Immediately stops the motor rotation.

<Accel Limit On>

Enables the acceleration/deceleration function in the speed control mode.

<Direction>

Changes the rotation direction.

<Clear P-error>

Clears the position deviation counter. (This counter is used when pulse strings are input.)

< Position Reset>

Resets the position information.

—20-
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* Supplementary information about “Servo Command”

“Servo Command” contains items to which a function is added that turns those items OFF automatically after their
checkboxes are checked.
These items are [Clear Alarm], [Clear P-error], and [Position Reset]. Since these items need not always be turned ON, the SV
Programmer turns them OFF automatically after data is transferred to the driver.
The items [Smooth Stop], [Hard Stop], and [Accel Limit On] turn ON or OFF automatically when you click the [Stop], [Set], or
[Start] button on [Command Data] and [Profile Data] described in the next section.
[Stop] button: When you click this button, [Smooth Stop] and [Accel Limit On] turn ON automatically.
[Set] button: When you click this button, [Accel Limit On] turns ON automatically; [Smooth Stop] and [Hard Stop] turn OFF
automatically.

[Start] button: When you click this button, [Smooth Stop] and [Hard Stop] turn OFF automatically.

21—
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[Servo Status]

Displays the servo status. The red steady light indicates the Status ON status.

Servo Status

. Servo On . Forward Limit
. Profile . Feverze Limit
. InPosition . Torgue Limit

Bl rautt B velocity Limit

<Servo On>
Turns the status ON during Servo ON.

<Profile>

Turns the status ON while profile operation is in progress.

<InPosition>

Turns the status ON when in-position is achieved.

<Fault>

Turns the status ON when an alarm is detected.

<Forward Limit>

Turns the status ON when the forward direction soft limit is reached.

<Reverse Limit>

Turns the status ON when the reverse direction soft limit is reached.

<Torque Limit>

Turns the status ON when the torque limit is reached.

<Velocity Limit>

Turns the status ON when the speed limit is reached.

—-22 -
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[Profile Data]

Sets the profile operation. The profiling status of the servo status remains ON while the profile operation is in progress.

Profile Data
TGT Position 256512 | [ pulse 1
TGT VYelocity 3000| [ rpm ]
Acceleration 10000 | [ Orpm#=]
Deceleration 500| 0orpm£=]
| Stop | | Htart |

<TGT Position>

Sets the target position (ID:32) of the profile operation (unit: pulse).

<TGT Velocity >
Sets the target speed (ID:33) of the profile operation (unit: rpm).

<Acceleration>
Sets the acceleration (ID:34) of the profile operation (unit: 10 rpm/sec).

The value of ID:34 is used for both acceleration and deceleration of profile operation.

[Start] button: Starts the profile operation.
[Stop] button: Stops the profile operation.

—23-
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[Servo Gain]

Sets the servo gains.

Servo Gan
Kpl 100| LPF_f 1000
Kvl 200| MF_f 1000
Kil 126| MWF_d 1000
Load a0
Read | | Set |

<Kp1>
Sets the position loop proportional gain 1 [1/s].

* The unit [1/s] applies when the load inertia is set properly.

<Kv1>
Sets the speed loop proportional gain 1 [1/s].

<Ki1>
Sets the speed loop integral gain 1 [1/s].

<lLoad>
Sets the load inertia [gecm2].

<LPF_f>

Sets the lowpass filter frequency [Hz].

<NF_f>

Sets the notch filter center frequency [Hz].

<NF_d>

Sets the notch filter attenuation.

[Read] button: Sets the present servo gain values to the driver.

[Set] button: Sets the present servo gain values to the driver.

—24 -
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[Help Pane]

Descriptions of the parameters selected in the List of Parameters are displayed.

whisl
bats ID i [e0]
LRCA Mams [ Segve Scaces |

Zgpvo SCACUS

ED { Barva Om

Bl ! Frafile working
EZ 1 In Fosition

B3 1 State of Faulc
B4 1 Forward Limiz
BS i Beverse Limik
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Controller Setup

You can reference and set parameters of the SV-NET controller.

Controller Setup Functions

e Function to start SV-NET controller connection and obtain SV-NET controller parameters
1. Starts connection with the SV-NET controller.

2. Obtains the parameters of the SV-NET controller.

e Function to manage SV-NET controller parameter files
1. Obtains parameters from a text file.
2. Saves parameters in a text file.

3. Saves parameters in the SV-NET controller.

e Switch Data Type Display function

1. Displays the parameter values in decimal or hexadecimal notation.

e Switch Parameter Display function
1. Displays the parameters in a list.

2. Displays parameters by categories.

e Print function
1. Prints the parameter list on the printer.

2. Displays the preview of a print image.
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|Description of the Controller Setup Window

The configuration of the Controller Setup window is as follows:

Tool Fane Parameter Pane

0

=

Help Pane
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[Tool Pane]

The following table describes each tool button used for controller setup.

Group Button Description of function
Search Net Starts communication with the SV-NET controller
= Search

and obtains the controller product information.

Obtains parameters from the SV-NET controller.
% Read All

) Reads parameters to the SV-NET controller. *Note
I Write All

File Reads a parameter file.

= Open

Saves a parameter file.

lal Save

Prints a parameter list on the printer.

=i Print

i Displays the print image of a parameter list.
& Preview

Saves parameters in the flash memory of the

% Flash
5#_'
- SV-NET controller.
Data Displays parameter values in decimal or
) DEC
hexadecimal notation.
{3 HEX
View Displays all the parameters in a list.
22| all

i Displays parameters by categories.
:= Category

* Note:
When you click the [Write All] button, all parameters with a rewritable data ID are changed.

Make sure that all the parameters displayed in the list are correct before clicking the [Write All] button.
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[Parameter Pane]

This section describes the contents of the parameter pane.

[System] Tab Page

[SV-NET Controller Information]

This tag page displays the product information of the SV-NET controller.

SVY-MNET Coniroller Information

Hardware-1ID

Software-ID

Yersion Model Humber

Serial Humber

= CC-|l

=TANDERD

YERT.00OL | TAS440M2000E100

=AMPLE

Outline of SV-NET Controller Product Information

<Hardware-ID>

Displays the product type of the SV-NET controller.

< Software-ID>

Displays the software ID of the SV-NET controller.

<Version>

Displays the software version of the SV-NET controller.

<Model Number>

Displays the product model of the SV-NET controller.

< Serial Number>

Displays the serial number of the SV-NET controller.

Copyright© 2008 Tamagawa Seiki CO.,LTD
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[Memory Switch]
You can reference and set the memory switch of the SV-NET controller.
The memory switch is used to determine the operation to be started after the SVC is powered on.

ltems other than “Auto run task number 0” are inaccessible.

Auto run task nember 0

RHd| 5-;||

Outline of Each Item
<Auto run task number 0>
Executes Task 0 automatically on startup of the SV-NET controller.

The setting of the memory switch must be saved to flash memory.

<Read>

Obtains the memory switch data.

<Set>

Sets the memory switch data.

-30-
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[SV-NET Baudrate]
Sets the baud rates for the SV-NET controller.

SV-NET Baudrate.

[SV-NETGHI | TMbes -

| [ |HaadI|Eat

Outline of Each Item

<SV-NET CH1>
Sets the baud rate for SV-NET Channel 1.
The baud rate options are 250 kbps, 500 kbps, and 1 Mbps.
The default value is 1 Mbps.

* Note:
The default baud rate of the SV-NET driver is 1 Mbps.
Communication is disabled if the baud rate is changed.

Ordinarily, the baud rate need not be changed.

<SV-NET CH2>
Sets the baud rate for SV-NET Channel 2.
The baud rate options are 250 kbps, 500 kbps, and 1 Mbps.
The default value is 250 Mbps.
Some SV-NET controller models do not support SV-NET Channel 2.

<Read>

Obtains the SV-NET baud rate value.
<Set>

Sets the SV-NET baud rate value.

—-31-
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[MCH Configuration] Tab Page

[MCH Cpnfiguration]

This tag page is used to set the mechanism configuration.

! MGH Gonfiswation
MCH Type £ Max Axiz Emargoncy Limit
MGH Typs | Limit Action Wi =
Max Axis | DD Numbor DD =
LS Humbar Twalid o
focle Numbes Starting Home Mode
ST — =]

[MCH Type / Max Axis]
<MCH Type>
Mechanism type (0: Not used; 1: Simple mechanism)

This item cannot be set.

<Max Axis >
Sets the maximum number of axes permitted to belong to the mechanism.

This item cannot be set.

[Axis Number]
Sets the driver axis number for an axis that belongs to the mechanism.

The driver axis number is different from the MAC-ID. This item cannot be set.
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[Emergency Limit]

Sets the emergency stop limit.

< Limit Action>

Sets the operation after stop caused by the emergency stop limit. Select any of the following operation options:

[Options]

Ignore

Smooth

Hard

Smooth2

Hard2

Alarm + Smoth

Alarm + Hard

Alarm + Smooth2

Alarm + Hard2

<DIO Number>

Sets the DIO number to which the emergency stop limit is assigned.

<LS Number>

Sets the LS number to which the emergency stop limit is assigned by a bit pattern.

[Starting Home Mode]

Sets the origin mode at power-on.

<Home Mode>

Select any of the following mode options:

[Options]

Home

Not Home

—33-
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[Argument Check Level]

Sets the move to be performed if 0 is given as the argument for speed or time.

<Level>

Select any of the following options:

[Options]

Ignore

Warning

Alarm + Smooth

—34-
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[Display of Information of Each Axis by Categories]

This window is used to set each axis belonging to the mechanism.

Axizl
Moior Type Gpoed Limst Ll ity Hessazi
Someor Puloe 48] [pubee] N <] =
Wz Speed E00) [rpm] 1WI _—
[ HEX [0.01%] [ HEX
WG/ DEC : . : ;
Paoitive Solt Limit Pouitive Hard Lisit
Ao Dec Tmel 200 [meenc]
Acc-Dec Time? 00| [mescc] | Limit At i Smooth Slep w | Limit fcton knirn
| *5oil Limit TRPMEISY | | DI Mumbes ]
15 Mumber Ervalid
Axis Type L] HEX [dna]
Axie Type Rotalion w | Hegative Soft Lima Megative Hard Limi
- it | Limit At on Smeathtop v | Limat Aeciam lanirn
e o !M; [pbec] | —Eali Limit ~EOAEEE | m 0e0 0
Walocity - | O] HEX _H-I.E [ el
Read | | set |

[Mortor Type]
<Sensor Pulse>

Sets the number of encoder pulses per rotation of the motor.

<Max Speed >

Sets the maximum speed value (unit: rpm) for the motor.

[ACC/DEC]
<ACC/DEC Time1>

Sets the length of the 1st acceleration/deceleration buffer (unit: msec).

<ACC/DEC Time2>

Sets the length of the 2nd acceleration/deceleration buffer (unit: msec).

[Axis Type]
< Axis Type>
Sets the axis type.

The instruction units are mm for the linear-motion axis and deg for the rotation axis.

Select any of the following options:
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[Options]

Linear

Rotation

Linear2

Rotation2

<Pulse Rate_n>

Sets the numerator value (unit: deg or mm) for the pulse rate.

<Pulse Rate_d>

Sets the denominator value (unit: pulse) for the pulse rate.
<Velocity Unit>
Sets the speed unit.

Select any of the following options:

[Options]

0.01%

[deg/sec]

Rpm

* A speed unit of 0.01% is based on the set value for “Max Speed” of the motor type.

[Speed Limit]
<Limit Action>
Sets the move to be performed when the speed limit is reached.

Select any of the following options:

[Options]

Ignore

Smooth Stop

Hard Stop

Clamp

Warning + Clamp

Alarm + Smooth Stop

Alarm + Hard Stop
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< Speed Limit>

Sets the speed limit (unit: speed unit).

<HEX>

Displays the value in hexadecimal notation.

[Positive Soft Limit]
<Limit Action>
Sets the move to be performed when the forward direction soft limit is reached.

Select any of the following options:

[Options]

Ignore

Smooth Stop

Alarm + Smooth Stop

<+Soft Limit>

Sets the forward direction soft limit (unit: instruction unit).

[Negative Soft Limit ]
Limit Action>
Sets the move to be performed when the reverse direction soft limit is reached.

Select any of the following options:

[Options]

Ignore

Smooth Stop

Alarm + Smooth Stop

<-Soft Limit>

Sets the reverse direction soft limit (unit: instruction unit).

[Infinity Reset]
<Infinity Reset>
Sets the coordinate reset value for an infinite length axis. The setting is valid if the axis type is set to infinite rotation axis or

infinite linear-motion axis.
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[Positive Hard Limit]
<Limit Action>
Sets the move to be performed when the forward direction stroke limit is reached.

Select any of the following options:

[Options]

Ignore

Smooth Stop

Hard Stop

Alarm + Smooth Stop

Alarm + Hard Stop

<DIO Number>

Sets the DIO number to which the forward direction stroke limit is assigned.

<LS Number>

Sets the LS number to which the forward direction stroke limit is assigned by a bit pattern.

[Negative Hard Limit]
<Limit Action>
Sets the move to be performed when the reverse direction stroke limit is reached.

Select any of the following options:

[Options]

Ignore

Smooth Stop

Hard Stop

Alarm + Smooth Stop

Alarm + Hard Stop

<DIO Number>

Sets the DIO number to which the reverse direction stroke limit is assigned.

<LS Number>

Sets the LS number to which the reverse direction stroke limit is assigned by a bit pattern.
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[Read]

Obtains the data of each axis.

[Set]

Sets the data for each axis.

* Note:

The axis number indicated at the top of this window is the axis number in the mechanism.
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[I/O] Tab Page
This tab page displays the 1/O information.

5. 8" W-MET Gupienliar fimiup
Systum HCH | W0 | Taxk, Btk Cther

<Label [A]>
Sets inputs to contact A.

Clicking this label causes contacts A and B to switch.

<Label [B]>
Sets inputs to contact B.

Clicking this label causes contacts A and B to switch.

<Read>

Obtains the I/O information.

<Set>

Sets the I/O information.
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[Task] Tab Page

This tag page displays the task information of each axis.

A 5y MET Gontraller Satup

A
i

System MCH Lo [ Task | Metwork Ofther
Variable
Alarm Lewel
| Alarm Level | sStp -
R T
Toak1 [ Task? | Taskd | Taskd | TaskG | Tackf Task 7 | Task @l

<Local Variable >

Displays the number of local variables available for the task.

< Stack Size>

Displays the number of stack sizes available for the task.
<Alarm Level>
Sets the task stop operation to be performed when an alarm is issued.

Select either of the following options:

[Options]

Stop.

Run

<Read>

Obtains the task information.

<Set>

Sets the task information.

—41 -

Copyright© 2008 Tamagawa Seiki CO.,LTD




[Network] Tab Page

This tab page is used to set the RS232C communication with the connected device.

RS232C Basic Sehup
[ s -
L
[ I
_ Error happened Not stop RS-232C commm [n) = |
_ Eevence serial communication ASCH - |
_ 200[  [meec]
L —
R5232C Auto Commun ication Settng
| Auto Mode | Resdirite =]
| R5232C Device Read Top Address | 0] ] HEX
| AS232C Device Write Top Addecs | 64| [] HEX
Data Humber o4
Repeat Humber 1
Metwork Varishle Read Top Address 0| [] HEX
Metwork Varishie Wite Top Address 64| ] HEX
Com Interval 200
Device Number 68| [] HEX
Device Mumber? 0| ] HEX

RS232C Basic Setup

Makes the basic settings for RS232C communication with the connected device.

<Baudrate>
Sets the communication speed.
[Settable Speeds]
9600 bps/19200 bps/38400 bps/57600 bps

< Data Bit>
Sets the data bits.
[Options]

8bit

7bit
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< Stop Bit>
Sets the stop bit(s).
[Options]

1bit

2bit

<Parity >
Sets the parity.
[Options]

none

odd

even

<Alarm Action>
Sets the operation to be performed when an alarm is issued.

[Options]

Error happened, Not stop RS-232C communication

Error happened, Stop RS-232C communication

<Protocol Type>
Sets the communication protocol with the connected device.

[Options]

No Connect Equipment

Digital Memory Link (ASCII 1:1)

Keyence serial communication ASCII

Keyence serial communication Binary
MITSUBISHI GOT-A900 Type1
MITSUBISHI GOT-A900 Type2

Computer Link Type1

Computer Link Type4

<Time Out>

Sets the wait time (msec) until an alarm is issued after communication is disconnected.

<Response Wait>
Sets the reception wait time (msec).

This item must be set when the communication type is the computer link protocol.

—43 -

Copyright© 2008 Tamagawa Seiki CO.,LTD



RS232C Auto Communication Setting

Makes the settings for automatic reading and writing to and from the device area of the connected device.

< Auto Mode >

Sets the automatic send/receive mode.

[Options]
Read/Write Always reads and writes to and from the specified device area of the connected device.
Read Always only reads from the specified device area of the connected device.
Write Always only writes to the specified device area of the connected device.

<RS232C Device Read Top Address >

Sets the first address of the connected device at which reading begins.

<RS232C Device Write Top Address>

Sets the first address of the connected device at which writing begins.

<Data Number>

Sets the number of data items to be read and written per communication session.

<Repeat Number>
Sets how many times read and write are repeated.

The data amount calculated by <Data Number> x <Repeat Number> is the total amount of read and written data.

<Network Variable Read Top Address>

Sets the starting address of the destination where the network variables are read at the time of data reading.

<Network Variable Write Top Address >

Sets the starting address of the source where the network variables are written at the time of data writing.

<Com Interval>

Sets the communication interval (msec).

<Device Number1, Device Number2>
These items are used by the computer link protocol.

Example: 1st character: D (0x44), 2nd character: not used
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<Read>

Obtains the task information.

<Set>

Sets the task information.
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[List of Parameters]

Displays a list of the SV-NET controller parameters.

Glase Mame | Ols 1D | Gogp D | I Cuts Plawss Diatn Vshse Deta Tope | Wrte Ensbls o
v IEEE oo ] ] Mumary swilch 14338 r NG
EYE_H o001 1] 1 B g 0084 ing pos s 200 r M
SYG M LD 1] 2 Mast commend wppes bo ] r M
BYE ¥ D=ililil [ E] Hazt cnmmand determin n r [T
EYE X n=0018 1] 4 Variable numbe in hast o r NG
5YE M [ 1] ] Task rumber in host oo -1 r i
S¥E M [T ] ] Hesnres ] r M
BYE K =il [ 7 Fuznren 0 r [T
EYE X =001 1] 8 Ficzuren o r NG
EYE X LA 1] ] Feaniee ] r M
S5 M [ 1 ] Model Mumber TA Baan r NG
AYE X il 1 1 Wnde| Mumbes M 000 r [
E¥E X [T 1 2 Hude| Humlier E 100 r HE
EYE_X o001 1 3 Serial Humber] 105 THENG r M
S¥S M [T 1 1 Gierisl Mumbes3? 12 FE5EMON r [
AYE K it i 5 Fuaznren -1 r Mk
EYE X =018 1 [ Fiezuren -1 [ NG
5YEX [ 1 7 Resntee -1 r N3
Y5 M LLEnL 1 L] Fesnres =1 r .
BYE K =il 1 9 Fuaznren -1 r [

Outline of Parameters
<Class name>
Displays the parameter class names.

Example: SVD_1 = Axis 1 of the driver, MCH_1 = Mechanism 1

<Class ID>

Displays the class IDs of the parameters.

<Group ID>

Displays the group IDs belonging to the parameter classes.

<|D>

Displays the item IDs in the group IDs.

<Data Name>

Displays the parameter names.

< Data Value>

Displays the parameter set values.

<Data Type>
Switches the notation of parameter values between decimal and hexadecimal.

(Unchecked: Decimal, Checked: Hexadecimal)
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<Write Enable >

“y”

“O” indicates that the parameter is rewritable; “x” indicates that the parameter is not rewritable.
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[Help Pane]

When you place the mouse pointer on a group box, description of the associated parameter is displayed.

w Help

- 2 X
Class Name [ 5Y5 %]
Claza ID [ Ox0010 ]
Group 1D [ 1]
pats 1D [ 2]
Dace Name [ Serisl Numberi ]

Serial nusber (the first four characters)
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JOG Operation

This window is used to perform a test run of the motor after the parameters are set by device setup and controller setup.

JOG Operation Functions

e SV-NET controller connection

1. Searches for the drivers connected to the SV-NET controller and displays JOG control for each of the connected axes.

¢ JOG operation function
1. Executes JOG operation (constant-speed continuous feed) for all axes.

2. Executes Servo ON, Servo OFF, and Servo FREE for all axes.

e Speed override function
1. Executes speed override in the range of 0% to 100%.

* The rpm of the motor is changed with respect to the reference rpm.

e Switch JOG Control Display function

1. Switches the JOG control display for all axes and that for each axis.

¢ JOG control function
1. Executes JOG operation (constant-speed continuous feed) for each axis.
2. Executes step operation (fixed-distance feed) for each axis.
3. Executes Servo ON and Servo OFF for each axis.
4. Executes Reset Alarm for each axis.

5. Executes Reset Position for each axis.
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|Description of the JOG Operation Window

The configuration of the JOG Operation window is as follows:

JOG Caontral
Fane

Toaol Fane
- o
- a W
'-d“ L oo = : ml:ul—

) Haghi: 3000 [rpm )
1 M 1500 [ ]
G Ded - 500 [rpm ]
) Lowm : 100 [mem]

|| Moade
(L | F— ( @ dm O S
T
v & | (oo | Uit | Cammard v

TenlButton
[ — O R P P TN
D | e — | O ER

| Menier c X
— —— oo
Mch Status Serve Slaus ———, L ] PR —
Inba rpoivion EEEE B2 ) Fgh : 5000 [ pm ]
T i Wkt B T 1 Mg 1600 [eee ]
Madg Toapslinsd & Dwd - 500 [rpm ]
Horsee I T 1 o 1 [ ]
Vi Lt
+8of Linfl [T ——y Hodde
— l | [Com o=
= = =
‘Wuner
By Bl LU Carerard w
1 o i ——

Mechanismilo

Monitar Pane
—_
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[Tool Pane]

The following table describes each tool button used for JOG operation:

Toolbar group Button Description of function
Search Met Starts communication with the SV-NET controller and displays
=
Search the number of currently connected axes.
CMD Executes Servo ON for all axes.
% SVON
Executes Servo OFF for all axes.
< SYOFF
Executes Servo FREE for all axes.
& SVFREE
Executes Reset Alarm for all axes.
s+ ALMBRST
JOG Executes JOG operation in forward direction for all axes.
o CW
Executes JOG operation in reverse direction for all axes.
G CCW
Override j Executes speed override for all axes.
0% 50% 100%
100 (&)=
View Displays JOG control for all axes in a list.
a4 all
Displays JOG control for each axis in tabular form.
] Tab

—-51-

Copyright© 2008 Tamagawa Seiki CO.,LTD




[JOG Control Pane]

The JOG operation information pane displays JOG control for each of the axes connected to the SV-NET controller.

Axiz 1
r Servo Status ~ F ~apead Level-
Serwoln FormardLimil (C) High - 3000 [rpm ]
Profie e verseLimit 3 Med 1500 [rpm ]
InPosition TorqueLimit (=) Detf : 500 [rpm ]
Fiault elocityLimit 3 Low - 100 [rpm ]
— H..-l.-i.r mSta ilp; Moide
| () Jog () Step |
Step '
Lrit | Command v
s Servo Feed Back ~ Tool Button 4
"""" e | ) (o0
UL epm ]
~ Current T 0o1A] | G cow Jlo ow |

[Servo Status]

Displays the servo status of the SV-NET driver.

Status name Description of status ON OFF
Servo On Servo ON [ | |
Profile Profile operation is in progress. [ | |
In Position In-position | |
Fault An alarm is detected. | |
Foward Limit The forward direction soft limit is detected. [ | |
Reverse Limmit The reverse direction soft limit is detected. [ | |
Torque Limit The torque limit is detected. | |
Velocity Limit The speed limit is detected. [ | |

[Alarm Status]
Displays the alarm status of the SV-NET driver.

[Servo Feed Back]

Displays the servo feedback information of the SV-NET driver.

Feedback name Feedback information
Position Present position
Velocity Present speed
Current Present electric current

[Speed Level]

Specifies the reference rpm of the motor (for 100% override).
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Number of rotations
Speed level
Unit: rpm
High 3000
Mid 1500
Def 500
Low 100
[Mode]
Sets the mode of test run.
Item name Description
Jog / Step Selects JOG operation or step operation.
Step Inputs a move distance in step operation mode.

Changes the instruction unit for the move distance.
Unit [Command]: Instruction unit of move specified by controller setup

[Pulse]: Pulse unit

[Tool Button]

Executes an operation for the JOG control-target driver.

Button Description

Executes Servo ON.

Executes Servo OFF.

Executes Reset Alarm.

Resets the position information.

I H \I\ \I\

04

Rotates the motor in the forward direction.

The motor remains rotating while this button is held down.

Rotates the motor in the reverse direction.

0
o
o
¥

The motor remains rotating while this button is held down.
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[Mechanism/IO Monitor Pane]

This pane displays the mechanism status and general I/O information of the SV-NET controller.

Mchl DIO 1
Mch Status

IN ouT
Interpolation I ouT.o
O Acceleration 1M1 auTd
Faving k2 ouT2
Hearmi I3 ouT3
iz e ouT 4
Welocity Limit IME OuTs
+Soft Limit MG ouT.6
Ay M7 ouT?
SoftLimit E ouT 2
Aarm T ouTD

‘Warning IM10 auTian

Stop Status it CCIRY

1M1 2 auTiz

Home Status TEE ouTd2

1M1 4 ouT1 4

IR 5 OuUTi6

[MCH Status]

Status name

Description of status

Interpolation

Interpolation calculation is in progress.

De Acceleration Acceleration/deceleration is in progress.
Moving Axis is moving.
Homing Homing
Velocity Limit The speed limit is detected.
+Soft Limit The forward direction soft limit is detected.
- Soft Limit The reverse direction soft limit is detected.
Alarm An alarm is detected.

Warning A warning is detected.

Stop Status A stop processing instruction is input.

Home Status

The origin is fixed.

[I/O Status]

Displays general I/0 information of the SV-NET controller.

Status name Description of status ON OFF
IN Input status [ | |
ouT Output status [ | |
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Program Grid

This window is used to perform operations ranging from creating to executing and debugging a program designed specifically

for the SV-NET controller.

Program Grid Functions

e Program editor function

e Program download and check function
e Program debug function

o Servo monitor function

¢ Variable supervision function

e Task monitor function
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|Description of the Program Grid Window

The configuration of the Program Grid window is as follows:

2
ol =

3 =
W Prowrss Grid [ G-Eark¥Posfiioning S22 mm |

| Expleesr -8 X Fopument - x
= o Pontisning fE3E - Ha Fdorme Vake Mo | Moy | Vel | Comeent &
[ —s » [lrsn 1 REIE.
9 Mar E=l 1 mmD. W L=l
1 Akt m 7 mm5. @ =N
1 Hernatode £ 1 kmF. @ Py
1] DR SwasT L A FmA W P
] P L E:) | & Frmf.  DnB | Fosm
[T = 8K | I8 AU | Srxiem 6 FaT. W0 RerE
o] 2] [ 7 FmA. 0 RS
Fe s | |60 ET i FmA. 0 REZEE
HE S 3 Pmw. M REE
| WLl W el E= W emG. W | REm
£ 1 Prm Medd o ¥
5 Open ™ PFola | g 3&,_' - 8K
o Seve 4 Topy

i
2 b El
ElGotlatin | 0 pojese

=

it g B - |l g e A i | Ot 2 Erer () G (el [ bt (e g Tk ] DO e [T
)

< -
@ @
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[File Pane]

This pane is used to create new program files and add or delete existing program files.

Program file

W& Explorer

---------- 1 AutoMode
---------- ] Marualtode
---------- ] ChkStatuzTask

---------- 1 Function

Split file

— | [=--:— Positioning_R5232

.......... J Main
Program File Menu (Right Click)
Name Description of function
New File Creates a new program file.
Open File Opens an existing program file.
Save File Saves a created program file.
Adds a program to the file pane.
Add File
A maximum of four program files can be added.
Delete File Deletes a program from the file pane.
Build Builds a created program.
Download Downloads the program data to the SV-NET controller after the program is built.

Split File Menu (Right Click)

Name Description of function
ReName Changes the name of a split file.
Adds a split file to the tree.
Add Asm
A maximum of 100 split files can be added.
Delete Asm Deletes a split file from the tree.
Move On Moves a split file to the upper tree.
Move Under Moves a split file to the lower tree.

Copyright© 2008 Tamagawa Seiki CO.,LTD
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[Tool Pane]

The following table describes each tool button used for the program grid:

Group Button Description of function
File . Creates a new program file.
T] Mew
Reads an existing program file.
= Open
Saves a program file.
[z Save
Saves a program in the flash memory of the SV-NET
52 Flash
controller.
Build o i Builds a created program.
ek Build
E Down Writes the object file to the SV-NET controller after
— building a program.
i Reads a program from the SV-NET controller and checks
E Collaton
it against the currently edited program.
) Executes a program.
-y Start
Starts Task 0.
) Stops a program.
&& Stop ps a prog
Override Executes speed override.
—j Speed override is possible even during program
0% 50%100% execution.
100 (=)(%)
Edit Undoes an edit.
] Undo
* Refer to the “Details of Redoes an edit.
™ Redo
the Edit Functions of the
Program Grid.” ) Copies the selected range.
=3 Copy
Cuts the selected range.
4  Cut
Pastes the copied data.
[, Paste
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Pastes the copied data after inserting a line.

e Insat
== Paste
Inserts a line.
= Insert
Deletes a line.
» Delete
CMD Executes Servo ON for all axes.
+# GWON
Executes Servo OFF for all axes.
& SWOFF
Executes Servo FREE for all axes.
& SVFREE
Executes Reset Alarm for all axes.
= ALMRST
. Executes Deceleration Stop for all axes.
S, STOP
TINyG Sets the mode of program execution.
Normal |Normal mode of program execution
Debug &
Mor mall Mode in which the debug functions
including step execution and task
Debug
Debug |[display are enabled.
Some functions such as Edit Grid and
Copy & Paste are disabled.
— Task Sets the Trace Program.
= 'U"
e Task
Starts Trace Program.
View
Non
= HNon Stops Trace Program.
= Digplar Display
i Sets a breakpoint in the currently selected program step.
{l) Break
Breakpoints can be set only in Task 0.
i Resets the currently set breakpoints.
# Release
Restarts the currently stopped program.
il ReStart
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&= Step In

Executes the currently stopped program step and stops

the program before executing the following step.
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[Grid Pane]

You can create programs by editing data in the grid pane. The grid pane consists of three grids: “Program Step Grid” to
create the program instructions, “Argument List Grid” to set the detailed information for the instructions, and “Variable List

Grid” to edit the variables. A maximum of 5000 program instructions can be created.

Ea ]

Lo

LTART

Grid

=T

Program Step

Timear

Tiyatam
Tack

Sistam

fystam

Syebam
Bl
Pasu
Timesr
Bt

Pacs
Systam
fiysiam

fiysbam.
fiystam

Variahle List
Grid

Argurment
List Grid
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Program Step Grid

The program step grid displays a program list.

Program Step
Mo LABEL G M -
264 H_SETUPD Jump JHPBIT
265 Home HOME
266
267 H_SETUM Jump JHPBIT
268 Home HOME
269
270 H_SETUP2 Jump JHPBIT
n Home HOME
272
273 H_SETUP3 Jump JHPBIT
274 Home HOME
215 br-

<No.>

Displays the line numbers in the program list. The program is executed in ascending order (starting from the top line).

<Label>

Sets the branch labels for branch instructions and others.

<CMG>
Selects the type of command. A list in which commands are categorized by types is displayed to allow you to select

commands for setting a command group.

<CMD>

Displays a list of the commands selected in the “CMG” column. Commands are set when they are selected from the list.
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Argument List Grid

The argument list grid is used to set the data of the command arguments.

Argument
[ Name Vel b
) I o :
1 SETUP 002
' 2 HS1 Hs[1]
' 3 MS1 Ms[1]
' F Z51 ZsM1
' § HMIO1 HMIO[]
i HMLS1 HMLS[1] -

<No.>

Displays the line numbers in the argument list. The number of arguments varies according to the command.

<Name>

Displays the argument names in the argument list.

<Value>

Displays argument values. Enter argument values.
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Variable List Grid
The Variable List Grid displays a list of the variables to be used in the program.
The variable is a place to save numerical information.
Variables are used for the simplification of entering argument data to the argument list and for additions and subtractions of

variable data in the program depending on the condition.

r )|

Walus G et ~

Mo Hame
» B eccile]l 200200200200,  HndEEESEE .
acc2(8] | 200.200,200.200,.. i EN2.

Prm_CGClpd... 20 GG-Linkgz ..
Prm_CCHXRY 0 CC-Link BURY...
Prm_EMDID 0 RS DL
Prm_EMLS 0 ERE2IEL.
Prm_EMACH.. 0 ERE TR

Prm_MPulse.. 2048204820482 . F—%——|oligk. .
Prm_MaxRP.. 5000500050005 F—%—8mE.-.
Prm_AxizTy.. | 0.0,0.0,0,0,0.0 i o
10 Prm_PRate.. 10001000,1000.1..  MAAL—F5F..
11 Prm_PRate.. 20482048 20482 MOAL—FEL. 3

- m e omea r | o mmsasnsn e e ikl Sk

0 = T I e L R =

<No.>

Displays the line numbers in the variable list.

<Name>

Displays the variable names. Enter variable names.

Restrictions on Variable Names

You can use any variable names as long as the following restrictions are observed:

¢ Only 1-byte alphanumeric characters and underscores (_) are allowed.
 Variable names are not case-sensitive.

¢ The variable name cannot begin with a numeric.

e Spaces cannot be placed in the middle of the variable name.

¢ Reserved words cannot be used as variable names.

Array
An array allows you to handle multiple variables in a batch.
An array can be specified by enclosing a numerical value in square brackets (example: [3]) following a variable name. This

numerical value indicates the number of variables to be handled.
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<Value>
Displays the initial values of variables. Only numerical values can be specified for initial values of variables.

When “Array Variable List” is selected from the menu displayed when an initial value is double-clicked or right-clicked, the

Array Variable List window is displayed.

<Comment>

Displays comments. Enter comments.
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Array Variable List
The array variable list allows you to edit the initial values of an array in a list.

When “Value” of a variable name defined by the Variable List Grid is double-clicked, an array variable list is displayed.

&

200

200
200
200
200
200

= B SN e W R = 32

200

| ok | | Cracel |

<No.>

Displays the argument numbers of the array.

<Value>

Displays the initial values stored in the array.

<OK>

Confirms the edited values.

<Cancel>

Closes the Array Variable List window without confirming the edited values.

Edit Menu (Right Click)

Name Description of function
Copy Copies the values of the selected lines.
Cut Cuts the values of the selected lines.
Paste Pastes the values of the copied or cut lines.
Insert Row Inserts the selected lines.
Delete Row Deletes the selected lines.
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[Subpane]

The subpane has the following functions:

1. Comment Pane
The comment pane is a text editor in which comments can be input. Input comments for each program step. The comment

text is automatically switched when another program step is selected.

ZiCommerd - O X
Axin] Home Exacile e
= = LT y -, 1 o | = | " 44 b 1
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2. Help Pane
The help pane is used to display help for the currently selected command. Help information is automatically switched when
another command is selected.

* Turn ON the Help Display function of “Utilities” to use this function.

w Heb ]

" AnD
[ Commard Name ]
ADD

: Conmard Argument :

A cos @ Moo B Frd [ 0ut 546w |LU) O (G5 Werch Hate L Mo | Tost (4 T00 e oe [ Te
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3. Find Pane
The search pane is used to search a program for a character string. Enter a search string in the combo list and then click

the [Find] button. For the searchable ranges, see the following table:

#4Fnd -0
SERRCH HOME - entacal 1ext 20
Mo Wb Carid Step Mo feg Mo War Mo L]
[ o ] Home STEFP 262 ] a
1 HOME STEP Fiie] 1 [
2 Hame STEP 585 0 a
i HOHME STEF 266 ] a
q Hame STEF 268 1] 0
B HOME STEP 258 1 il
£ Hame STEP Eo] 0 i
1 FCEE STEP ] i ]
] Haoipss STEP b ] i}
g HOME STEP 204 I a o
_;‘j TR TIRE ] Fandd g Ot + O E 1] . 1’.}]' § f-..;' ;I Hor g T JJ ‘{_ | =|
- Toolbar
Iltem name Description
[Find] button Starts search for the contents currently displayed in the search list box.
Search list box Used to enter the character string to be searched for.
When the list box is expanded, a list of the character strings searched for thus far is displayed.

- Grid
ltem name Description
No. Displays the search result number.
Value Displays the phrases containing the search string.
Grid Displays the grids of the strings that matched the search condition.
Step No. Displays the program line numbers of the strings that matched the search condition.
Arg No. Displays the argument numbers of the strings that matched in the argument list.
Var No. Displays the line numbers of the strings that matched in the variable list.

- Searchable ranges

Program step Argument list Variable list

Labels, command types, and Argument values can be searched | Variable names and initial values can

commands can be searched for a character string. (Argument be searched for a character string.
for a character string. (Line numbers and argument names are | (Variable line numbers and comments
numbers are excluded from excluded from the search range.) are excluded from the search range.)

the search range.)
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4. Output Pane

The output pane displays the results of a build and check.

= OQutput -0 X
ZY fz=zsmblier Building Start Bl

Building fuccessiul
Frogras Ztep Kumber ¢ 1328 ziep
Program HMemory Size @ 1680384 byke

Yariable Wemory Slze @ 2004 Gyte

¥ azzewbler Bullding Finizh
FEEELRR SRR ER BRSSP AL

R

S Com (e Felp |98 Fed |2y Outee (3 Erree (1)) Goen [ES1WER BS Nete |57 Mo (@ Task [ D0 | Jew 5] Thbk
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5. Error Information Pane
The error information pane displays information about the errors found during a build.

Double-click the cell where the content of a build error is described, you can go to the line where the build error occurred.

_yErmar List - B X
keon Eroe Code E=planaton Eror 'Word Rowm Fink=s &
.13- 2 Thie srgument tskes warisbless onh fmghvar 3
dre # F j Err- (L] Gon [Z5]Wntch 0 Het |G Ho gt .00 [ ke 5
- Grid

Iltem name Description

Icon Displays the error icons.

Error Code Displays the associated error codes.

Explanation Displays the descriptions of the error contents.

Error Word Displays the character strings that caused the error.

Row Displays the program line numbers in which the error occurred.

Note Displays the supplementary explanations of the error contents.
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6. Gain Pane

The gain pane is used to adjust the gain of each axis. Gains can be changed even during program execution.

== -5 X
Heeim 1 - SAVE FLASH
kel [ kil | LFF | HF 4 HF d loed |
= 2000 000 e | oo ) | e 3000
k=) 10m HHE = 5n 16353 1500
i i i
] 0 ] 0 ] 0 ! -
100 = 200 = 120 & 1100 = 1000 2 1000 2 13 &
_d [T F'ﬁ o 4 1] Gam ;_; 3 L3 o & JJ r:-- |
- Toolbar
Iltem name Description
Axis selection list Selects an axis for which the gain is adjusted.

[SAVE FLASH] | Saves the changed gain data in the flash memory of the driver.

button Note: Stop any running program before saving gain data.
- Slider

ltem name Description

Kp1 Changes the value of position loop proportional gain 1.

Kv1 Changes the value of speed loop proportional gain 1.

Ki1 Changes the value of speed loop integral gain 1.

LPF_f Changes the value of the lowpass filter cutoff frequency.

NF_f Changes the value of the notch filter center frequency.

NF_d Changes the value of the notch filter attenuation.

Load Changes the value of the load inertia.
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7. Watch Pane
The supervision pane is used to monitor the values of variables used in the program. Variables can be monitored after the

program has been downloaded.

LWk -0 X
3 COUNT B 0-59 & HEX DEC
Ha Hams Waks Disia Toges ke -~
] SeiFos T I
1 St 0 i
2 seiuD o r
=
5
X
B
=
I
-
=
=
r '
L
| w EE] = | L 5 Wishch |« <t - il ' !
- Toolbar
Iltem name Description
COUNT Displays the number of predefined variables.
[B] button Up to 100 variables can be monitored at a time. This button displays the previous list.

If the first list is being displayed, pressing this button has no effect.

Variable list Displays the number of the currently displayed variable list. Variable list numbers are

assigned according to the order in which the variables are defined.

[G] button Up to 100 variables can be monitored at a time. This button displays the next list.

If the last list is being displayed, pressing this button has no effect.

[HEX] button Displays all variable values in hexadecimal notation.
[DEC] button Displays all variable values in decimal notation.
- Grid
ltem name Description
No. Displays the variable list numbers.
Name Displays the names of the predefined variables.
Value Displays the variable values after data has been read.
Data Type Switches the data type of a variable value.
Checked: Hexadecimal
Unchecked: Decimal
Note Displays the comments on the variables.
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8. Monitor Pane
The monitor pane is used to monitor various information items such as the feedback data of the SV-NET driver and the
mechanism and I/O information of the controller.

For more information, see the [Servo Monitor] window.

S Wanitor o
UMIT Command =
Mechl Axis 1 Axis 2 -~
i Stahus Servo Stalus Servo Sislus
Inferpolrbon Sarwole Sarwlin
" DeAccelaration Frafs Frofe
[ InPosition InPositiom
" Homng " Faeit 0 Fault
Limits
A Sarve Feod Back Sarvo Feed Hack Soevo Feed Back
sl Rk ] PG -1 PDE [
Stop Shatys -8 1] [
! Hums 'Bhll-_ 1] = ' 1] 1
w

Id Do | gl Help sy Fred _a-:-;---- -E.‘ll-”'" II_“Ij GEain _f.;'-'nl-:l.‘;!lfl--- :'é Mo f Tk ‘“ [ _-;-: ; og __ITn.'--ﬂ-

- Toolbar
Item name Description
UNIT Switches the position data of the servo monitor between “Command”
(controller instruction unit) and “Pulse” (pulse unit).
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9. Task Pane

The task pane displays the status of each task during program execution.

o Taak -2 x
l Taszkl Task2 Taskd Taskd s
Task Status Tozk Status Tosk Status Tosk Status
STATUS STATUS [s1anc [ISTOR| ETATUE
IMDES 28 | moEx | -1 | INDEX -1 IMDE -1
| BTAD 512 [smazx | &2 [sTac | GH | ETADH EE
Db Coolor Diarbrisg Conbew Db Golbor Debug Golor
| i [ |
| Tazkh Taskt Task? Taskil
Task Status Tack Status Task Statlus Task Stalus
w
F

- Task monitor

J Coe= |8 Help M Fird 2 Dt _,‘dnr-- 1] Gain ‘g'-‘nl.'l.‘allgl--- 5 Mot | g Task ..U (] i0] i Jog | Tahle

Monitor window Status item Description
Taskl STATUS Displays “RUN” when the task is being executed.
Taszk Status INDEX Displays the current index of the task.
@_ STACK Displays the current stack pointer of the task.
IMDEX. 28 Debug Color Description
STACK 512
Color Displays the background color for the debug mode.
Debue Golor
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10. DIO Pane
The DIO pane is used to monitor the DIO /O statuses.

When a label in the OUT group is clicked, the status is output directly to the I/O device.
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11. JOG Pane

The JOG pane is used to perform JOG operation of each axis.

e
12 Gpeed ol Speed el GpeedLew! =4
Oy e0lnml G %00 rpm] (O 1alepm] G S0Llepm]) () 30frpm] (5 S5O[rpm]
-:_:: 00 [ rpm | |:_‘- 101 rpm ] (:;-lmlrrmj ' A0 rpm | : 100 [ rpm | |___'- 10 rpen ]
Mode _Mode miode
@ Jog O skp @ Joe O sep | @ dog () Step
Step Shep | 5w |
Pty 1582 Pagion | Pogition | il
[ Unit | Commend | hit || Gommed | Und | Commerd |
= T vl B & o = = Vool i o Tl B & —y
L7 )l # Jlse Jloe Il Lz L d 3 [[0e ) (fL# ]l #]l%] 0¢]
([c_ccw Jlo cow || |llc cow f[o ow || |i[c cow |[o cw |
e 9 1o 9 Frd (B0 Bt 1) D EWotch et 5 Mo g Tk () T o Jog
- Speed Level

Selects a speed from among 10, 50, 100, and 300 rpm.

= 0 X

L

) Tatile

- Mode
Item name Description
Jog / Step Selects JOG operation or step operation.
Step Specifies the move distance in step operation mode.
Position Displays the current position of the motor.
Unit Selects the display unit of the current value between “Command”
(instruction unit) and “Pulse” (pulse unit).
- Tool Button

Executes an operation for the JOG control-target driver.

Button

Description

Executes Servo ON.

Executes Servo OFF.

#

Executes Reset Alarm.

Resets the position information.

CwW

Rotates the motor in the forward direction.

The motor remains rotating while this button is held down.

G COW

Rotates the motor in the reverse direction.

The motor remains rotating while this button is held down.
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Details of the Edit Functions of the Program Grid

Results of edit operations on the program grid differ depending on the items selected for editing.

The following table shows the results of edit operations by items selected for editing:

Name] columns.) After
the copy operation, the
[Value] column value is
initialized to 0.

Command Condition Program step Argument list Variable list
Select a single cell. The step data of the The argument values of | The selected cell is
selected cell line is the selected cell are copied. (Excluding the
copied. copied. (Excluding the [No.] column.)
[No.] and [Argument
Name] columns.)
Select a line header. The step data of the The [Value] column The values of all
selected lines is copied. | values of the selected columns except [No.]
lines are copied. of the selected lines
are copied.
Select multiple cells. The step data of the The argument values of | The values of the
(Contiguous) selected cells is copied. | the selected cells are selected cells are
copied. (Selection of the | copied. (Selection of
[No.] and [Argument the [No.] column is
Name] columns is invalid.)
Copy invalid.)
Select multiple cells. Error. The argument values of | The values of the
(Non-contiguous) the selected cells are selected cells are
copied. (Selection of the | copied. (Selection of
[No.] and [Argument the [No.] column is
Name] columns is invalid.)
invalid.)
Select multiple line The step data of the The [Value] column The values of all
headers. selected lines is copied. | values of the selected columns except [No.]
(Contiguous) lines are copied. of the selected lines
are copied.
Select multiple line Error. The [Value] column The values of all
headers. values of the selected columns except [No.]
(Non-contiguous) lines are copied. of the selected lines
are copied.
Command Condition Program step Argument list Variable list
Select a single cell. After the step data of the | The argument values of | The selected cell is
selected cell line has the selected cell are copied. (Excluding the
been copied, the copied. (Excluding the [No.] column.) After
Cut selected line is deleted. | [No.] and [Argument the copy operation,

the values of the
selected cells are
cleared.

Select a line header.

After the step data of the
selected line has been
copied, the selected line
is deleted.

After the [Value] column
value of the selected
line has been copied,
the [Value] column value
is initialized to 0.

After the values of all
columns except [No.]
of the selected line
have been copied, the
values of the selected
cells are cleared.
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Select multiple cells.
(Contiguous)

After the step data of the
selected cells has been
copied, the selected
lines are deleted.

The argument values of
the selected cells are
copied. (Selection of the
[No.] and [Argument
Name] columns is
invalid.) After the copy
operation, the values of
the selected cells are
initialized to 0.

The values of the
selected cells are
copied. (Selection of
the [No.] column is
invalid.) After the copy
operation, the values
of the selected cells
are cleared.

Select multiple cells. Error. The argument values of | The values of the

(Non-contiguous) the selected cells are selected cells are
copied. (Selection of the | copied. (Selection of
[No.] and [Argument the [No.] column is
Name] columns is invalid.) After the copy
invalid.) After the copy operation, the values
operation, the values of | of the selected cells
the selected cells are are cleared.
initialized to 0.

Select multiple line After the step data of the | After the [Value] column | After the values of all

headers.
(Contiguous)

selected lines has been
copied, the selected
lines are deleted.

values of the selected
lines have been copied,
they are initialized to 0.

columns except [No.]
of the selected lines
have been copied,
they are cleared.

Select multiple line
headers.

(Non-contiguous)

Error.

After the [Value] column
values of the selected

lines have been copied,
they are initialized to 0.

After the values of all
columns except [No.]
of the selected lines
have been copied,
they are cleared.

Command Condition Program step Argument list Variable list
Always paste data The copied step datais | The copied argument The copied values are
based on the position | pasted starting from the | value data is pasted pasted starting from
of the current cell. current cell. starting from the current | the current cell.

Paste cell. (Selection of the (Selection of the [No.]
[No.] and [Argument column is invalid.)
Name] columns is
invalid.)

Command Condition Program step Argument list Variable list
Insert the line of the Permitted. Invalid. Permitted.
selected cell. (If
multiple cells have
been selected, insert
the lines of those

Insert cells.) Note that this
function permits
contiguous selection
only. Non-contiguous
selection is not
permitted.
Delete the line of the Permitted. Invalid. Permitted.
selected cell. (If
Delete multiple cells have

been selected, use
the same operation
as that for “Insert.”)
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Command

Condition

Program step

Argument list

Variable list

DEL Key

Select a single cell.

The data of the selected
cell is cleared. If a cell in
the [Label] column is
selected, the label is
cleared. If one cell in
either the [CMG] column
or the [CMD] column is
selected, the cells of
both columns are
cleared. (The [No.]
column cannot be
cleared.)

The data of the selected
cell is cleared to 0. (This
applies only to the
[Value] column.)

The data of the
selected cell is
cleared. (The [No.]
column cannot be
cleared.)

Select a line header.

All the values of all
columns except [No.] of
the selected line are
cleared.

The [Value] column
values of the selected
line are cleared to 0.

All the values of all
columns except [No.]
of the selected line
are cleared.

Select multiple cells.
(Contiguous)

The values of the
selected cells are
cleared. (For the
selection of [CMG] and
[CMD] columns, the
same operation as that
for “Select a single cell”
is used.)

The same operation as
that for “Select a single
cell” is used.

The same operation
as that for “Select a
single cell” is used.

Select multiple cells.
(Non-contiguous)

All the values of all
columns except [No.] of
the selected line are
cleared.

The [Value] column
values of the selected
line are cleared to 0.

All the values of all
columns except [No.]
of the selected line
are cleared.

Select multiple line
headers.

(Contiguous)

The same operation as
that for “Select a line
header” is used.

The same operation as
that for “Select a line
header” is used.

The same operation
as that for “Select a
line header” is used.

Select multiple line
headers.

(Non-contiguous)

The same operation as
that for “Select a line
header” is used.

The same operation as
that for “Select a line
header” is used.

The same operation
as that for “Select a
line header” is used.

e Undo and Redo Functions

These functions are enabled for the commands shown in the following table:

No. Program step Argument list Variable list Comment
Edit Label Line Edit Argument Value Edit Variable Value Edit Comments
1 (Including deletion by | (Including deletion by (Including deletion by
the DEL key) the DEL key) the DEL key)
2 Change Command Paste Argument Paste Variable
Group Combo
3 Paste Step Insert Variable Line
Insert Step Line Delete Variable Line
5 Delete Step Line Paste After Add Variable
Line
6 Paste After Insert Add Last Variable Line
Step Lines
7 Add Last Step Line

- 80 -

Copyright© 2008 Tamagawa Seiki CO.,LTD




Operations Disabled in Debug Mode

The following table shows the operations that are disabled in debug mode:

Group Operation

File

Build Download

Collation

Undo

Redo

0]

g

O

ut

Edit

Paste

Insert Paste

‘U|
@
@
—
®
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Monitor Variable

A monitor variable can be used for argument OP* of an arithmetic instruction or others. Monitor variables can cause a

branch to occur in a program according to the condition of the motor. The following is a list of monitor variables:

Variable name Description Meaning of the index
DI[*] Actual input DIO number
DO[*] Actual output DIO number
Al[*] Analog input AIN_CH number
AO[*] Analog output AOUT_CH number
TIM[*] Timer Timer number

TASK_STS[]

Task start status

Task number

SVD_CPLS[*] Instructed position pulse (with no origin offset) SVD number
SVD_FPLS[*] Present position pulse (with no origin offset) SVD number
SVD_FVEL[*] Present actual speed (rpm) SVD number
SVD_FCUR[*] Present actual electric current (0.01 A) SVD number
SVD_STS[*] Servo status SVD number
SVD_ALM[*] Servo alarm SVD number
SVD_LOAD[*] Overload monitor (0.1%) SVD number
SVD_TEMP[*] Driver temperature (0.1°C) SVD number
SVD_PWR[*] Driving power voltage (0.1 V) SVD number

MCH_CPLS["]["]

Instructed position (pulses)

Mechanism number and axis number

MCH_FPLS[*] [*]

Present position (pulses)

Mechanism number and axis number

MCH_FCUR[*][*]

Present actual electric current (0.01 A)

Mechanism number and axis number

MCH_FVEL[*] [*]

Present actual speed (rpm)

Mechanism number and axis number

MCH_FSPD[*] [*]

Present actual speed (speed unit)

Mechanism number and axis number

MCH_CPOS[*|[*]

Instructed position (instruction unit)

Mechanism number and axis number

MCH_FPOS[*] [*]

Present position (instruction unit)

Mechanism number and axis humber

MCH_SVSTS[*] [*]

Servo status of each axis

Mechanism number and axis nhumber

MCH_SVALM[*] [*]

Servo alarm of each axis

Mechanism number and axis humber

MCH_JSTS[*] [*]

Move status of each axis

Mechanism number and axis number

MCH_STS[*]

Mechanism status

Mechanism number

MCH_ALM[*]

Mechanism alarm

Mechanism number
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Shortcut Keys

The following table describes the shortcut keys available in the Program Grid window:

Key operation Operation

CTRL+Z Undo

CTRL+Y Redo

CTRL+C Copy

CTRL+X Cut

CTRL+V Paste

CTRL+I Insert Paste

Insert Inset

SHIFT + Delete Delete

F5 Start Program
F6 Download
F7 Display Task Trace Line At Beginning
F8 Display Task Trace
F9 Set/Reset Breakpoint
F11 Step-in
F12 Switch To Debug Mode
SHIFT+F5 Stop Program
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The Servo Monitor is used to execute the program created by the “Program Grid” and to monitor various information items

such as the feedback data of the SV-NET driver and the mechanism and I/O information of the controller.

Servo Monitor Functions

e Function to handle programs

1. Executes and stops a program.

e Monitor functions
1. Function to monitor the servo status and servo feedback of each axis
2. Function to monitor the mechanism and 1/O information of the SV-NET controller

3. Function to display the servo feedback data in graphical form

e Graphical function
1. Displays data of positions, speeds, and electric currents
2. Changes the scale of each item.
3. Graphically displays a maximum of three axes, allowing them to be compared.
4. Can display the X-Y plane.
5. Logging function (up to 8 sec at an interval of 8 msec)

6. Real time display function on an oscilloscope
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|Description of the Servo Monitor Window

The configuration of the Servo Monitor window is as follows:

Servo Monitar
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Tool Fane
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[Tool Pane]

The following table describes each tool button used for the servo monitor:

Group Button Description of function
Search Net Starts communication with the SV-NET controller and
=
Search displays the number of currently connected axes.
Task ) Executes a program.
&y Start
. Stops a program.
fa otop
LOG Starts or stops log data acquisition.
j Loe Start
Log Start | Starts logging feedback data.
Log Stop | Stops logging feedback data to
li Log Stop obtain the log.
: Switches the monitor display.
= Wiew
== Form
View Displays log data in graphical
Wave form.
View View Displays the servo status and
e Wave
Form servo feedback information.
Switches graphical display to X-Y display.
‘[Q,X YViewr-Y
Switches graphical display to oscilloscope display.
# Oscillo
Pauses oscilloscope display.
ﬂ Hold
Unit Sets the display unit for each monitor (position, speed,
and electric current).
Electric
- Unit Position Speed
Command current
Gommand
| Pulse | Pulse Pulse rom 0.01A
mm rpm 0.01A
Command
deg rpm 0.01A
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File

= Open

Opens saved log data.

[z Save

Saves the obtained log data.

Saves the present graph in an image file.

100 Z)=)

&l Image Select bitmap or JPEG format as the image file format.
CMD Executes Servo ON for all axes.
& GWON
Executes Servo OFF for all axes.
& SWOFF
Executes Reset Alarm for all axes.
2= ALMRST
) Executes Deceleration Stop for all axes.
S, STOP
Override j Executes speed override for all axes.
0%  BO0¥ 100%

* Notes:

1. The [Log Start] button and the [Log Stop] button in the tool pane are disabled in graphical display mode.

2. The instruction unit changes depending on the type of the parameter value of the SV-NET controller.
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[Servo Monitor Pane]
The information displayed in the servo monitor pane changes by switching between the [View Wave] and [View Form]

buttons.

1. When the [View Form] button is clicked

The servo status and servo feedback information for each of the currently connected axes is displayed.

Axizs_1

Servo Status

Serwoldn ForwardLimit

Profile RewerseLimit

InPosition TorqueLimit
Fault e locityLimit

fAlarm Status

. ]

Servo Feed Back

Pozition

[Servo Status]

Displays the servo status of the SV-NET driver.

Status name Description of status ON OFF
Servo ON Servo ON [ | |
Profile Profile operation is in progress. [ | |
In Position In-position [ | |
Fault An alarm is detected. [ | |
Forward Limit The forward direction soft limit is detected. | |
Reverse Limit The reverse direction soft limit is detected. | |
Torque Limit The torque limit is detected. [ | |
Velocity Limit The speed limit is detected. [ | |

[Servo Feed Back]

Displays the servo feedback information of the SV-NET driver.

Feedback name Feedback information
Position Present position
Velocity Present speed
Current Present electric current
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2. When the [View Form] button is clicked

Each information item of servo feedback is displayed in graphical form.

o[ rem

2000 | rpami )

-3000 | rpam )

The following table describes the button of each pulldown menu used for graphical display:

Pulldown menu

Description of function

Positm
View Twpe
Feedback -

Specifies the display mode of position data.

[Feedback]: Displays presently monitored position.

[Command]: Displays the instructed position.

[Feedback+ Commnad]:Displays both the present position and the instructed position.
[Command]: Displays the deviation between the present position and the

instructed position.

InPosition Yiew
Specifies the display position of in-position line in the range of +4 to —4.
1} -
Position =cae Sets the scale of position data.
unit : [dee ]
10000 -
_ Sets the scale of speed data.
1000 -
Current Scak Sets the scale of electric current data.
unit:[A]
1.0 -
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i -

Sets the scale of time interval.

Window Type

Single Window -

[Single Window]: Displays [View Axis], [Comp Axis1], and [Comp Axis2] in one window.
[Split Window]:  Splits the display of [View Axis] and [Comp Axis1] and that of [Comp

Axis2] into different windows.

1 -

Sets an axis number to be displayed in graphical form.

X Selects an axis to be compared against the axis set by [View Axis] and displays the
Comp Axisl
graph by dashed line when the label part is double-clicked.
1 -
] Selects an axis to be compared against the axis set by [View Axis] and displays the
Comp Axis?
graph by gray line when the label part is double-clicked.
1 -
_ This button is set for X-Y display.
Specifies an axis number to be displayed along the X axis of the graph.
1 -
i This button is set for X-Y display.
¥ Axis
Specifies an axis number to be displayed along the Y axis of the graph.
2 -
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e Example of a graph in which three axes are compared

e Tope
unit - [deg ]

{

i
£
B

e Example of X-Y display (arc interpolation move)

it
- § B
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[Mechanism/IO Monitor Pane]

This pane displays the mechanism status and general I/O information of the SV-NET controller.

Mchil DIO 1
Mch Status

IN ouT
Interpolation MO ouT.0
Cre Acce leration 1M1 auT 4
baine k2 ouT 2
o 1m3 auT 3
SIE I ouT 4
welocity Limit IME auTsh
+Soft Limit ING ouTg
Ay 187 auT?
SoftLimit TE auT &
Alarm e ouT D

‘Warning W10 auTia

Stop Status Jidy CL Al

1M1 2 ouTiz

Home Status TEE ouT 2

1M1 4 OuT 4

IR 6 OuTi6

[MCH Status]

Status name Description of status
Interpolation Interpolation calculation is in progress.
DeAcceleratiom Acceleration/deceleration is in progress.
Moving Axis is moving.
Homing Homing
Velocity Limit The speed limit is detected.
+ Soft Limit The forward direction soft limit is detected.
- Soft Limit The reverse direction soft limit is detected.
Alarm An alarm is detected.
Warning A warning is detected.
Stop Status A stop processing instruction is input.
Home Status The origin is fixed.

[I/OStatus]

Displays general |/O information of the SV-NET controller.

Status name Description of status ON OFF
IN Input status | |
ouT Output status [ | |
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Utilities

This software includes utilities for customization of each window and handling of special functions.

Utility Functions

e Customizing each window

e Setting forced parameter write

e Writing an SV-NET controller program
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|Description of the Utility Window

The configuration of the Utility window is as follows:

= Ermwonessti

ereral General Setting
Cord st
Drvicm S
: ﬁut.:.-"-rapw Sebing o lardusae
e Prograe fsd
> a ot ot
T — [ Dumplayr S larguisps sabecion deabog o s
Frogram W ding
Warafactur ing: Mars [FI——.
% Labal Batup
& Pspwresd pond Sehap [T The ken merw i S layed a1 a8 fives

Camvmwd Vel

[ Drpleyn comnand help n dhe pragran g wrcos

EEEIEE T

Contents of the menu
- Environment

- Device Setup

- SVC Setup

- Program Grid

- Parameter Writing

- Program Writting
- Label Setup
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Environment

This utility sets the general configuration of this software.

- General Setting

General Setting

Selecting a language

[+] Displays the laneuaes s=lection diske &t stariup

Mlera Har

[] The ican menu iz displavad at all fimes.

Commard Halp

[+] Desplays command help i the program erd window

| Dietauli || Save Cancel

- Selecting a language
< Displays the language selection dialog at startup>

Displays a language selection dialog box at startup.

- Menu Bar
<The icon menu is displayed at all times.>

Always displays the toolbar of each window.

- Command Help
<Displays command help in the program grid window>

Displays command help in the help pane of the program grid.

- Default

Resets all changes made in the Utility window to their defaults.

- Save
Saves the changed values.
- Cancel

Closes the Utility window. Changed values are not saved.
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- Controller Configuration

- CPU Type
<SV Controller CPU Type>
Selects the CPU type of the SV Controller from among SVCT, SVCC, and SVCW.

- Enhancing Type
<Enhancing Board1-4>

Sets each expansion board.
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Setting the Device Setup Window
Device Setup You can set the parameter list grid window for device setup.

Farameter Grid Lin=

Height 20 [%][(=]
Farameter Grid Back Caolor
idd rumber line LightCyvan At
Even mumber line ey e (¥
Parameter CGrid Forn
S LI Garthic || w Bald

- Parameter Grid Line

<Height>
Adjust the height of the parameter list grid.

- Parameter Grid Back Color

<0Odd number line >
Changes the background color for the odd-numbered lines of the parameter list grid.

<Even number line>
Changes the background color for the even-numbered lines of the parameter list grid.

- Parameter Grid Font
Changes the type and size of the font used in the parameter list grid.

Press the “Save” button to enable the changed settings.
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Setting the SVC Setup Window
SVC Setup You can set the parameter list grid window for controller setup.

The description of the set items is the same as that for Parameter List Grid Window for Device Setup.
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Setting the Program Grid Window

1. Program Step Grid
2. Argument List Grid
3. Variable List Grid
Program Grid You can set each grid window in the program grid.

The description of the set items is the same as that for Parameter List Grid Window for Device Setup.

4. Debug

Debug Information Setting

Task Wiew Back Calor
Tazk rumber 1 allows £
Task rimber 2 Sileer v
Task ramber 3 Sitver w
Task number 4 Siheer b
Tack rumber § Silear r
Task ruamber & Silver )
Task raimber 7 Siheer w
Task rumber 8 Sibver b

You can set the display colors for Program Tasks 1 to 8.

Press the “Save” button to enable the changed settings.

5. Array Variable List
You can set the array variable list window.

The description of the set items is the same as that for Parameter List Grid Window for Device Setup.

* Note:
After you changed settings of the Device Setup, SVC Setup, or Program Grid window, close the window and open it again

for those changes to take effect.
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Parameter Writing

Parameters of the SV-NET drivers and SV-NET controller, which are normally write-disabled, can be write-enabled forcibly.

Parameter Writing
Parameter compulsmn vrilrg

Press the “Authentication” button and then the “OK” button after entering a password, and the Forced Write Parameters

function is enabled.
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Program Writing
The firmware for the main unit of the SV-NET controller can be upgraded by using this function. Use the serial port for this

purpose.

Communication s=iting

COM Port COM1 W

Bawd Rate ET600bps e

The program file i@ opened

- Communication setting
<COM Port>
Select the port number for data transfer from among COM1 to COM16.

<Baud Rate>
Select the transfer speed from among the following values.

-> 9600 bps, 19200 bps, 57600 bps

- The program file is opened

Select the program file of the SV-NET controller main unit firmware.

- Program writing

Writes the program file to the SV-NET controller.
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Manufacturing Menu

This function cannot be used.
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Label Setup

You can define mechanism names, task names, names of individual I/O bits, and axis names.

MCH Name Setting
Sets a mechanism name.

The mechanism name for the mechanism status is changed.

Task Name Setting
Sets task names.

The task names in the program grid are changed.

Task Name Setting

Task1
Task2
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1/0 Name Setting
Sets the names of individual I/O bits.

The bit names for 1/O status are changed.

1/0 Name Setting
DIo 1
N ouT
0 [0 o [ouTo
1 [N 1 [OUT1
ETH 7 [OuT2
NI B |OUT3
4 [T 1 |o0Te
£ [INE E [OUTS
B (INE B |OUTA
7T 7 |[OUT7
EE EREIE
NI 5 o0Ta
10| 710 10| GO0
11T 10Ut
12|12 12| o012
EIRE] 13| o013
T4 | IM 14 14 OUT 14
15 | IM 15 15 | OUT 15
A ][] i AL

Axis Name Setting
Sets axis names.

The axis names in the Program Grid, JOG Operation, and Servo Monitor windows are changed.

Axis Name Setting

I -
=
P - o
D i
_ Bcis 7
D - |
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Menu Configuration

This section describes the functions selectable by the menu bar and the toolbar.

Menu Bar Functions

FilelEy  Wiew? EditiE) DebuetD? ToolfDd  Windowdd  Help(H)

File
- Project File -> New

Discards the current project file and creates a new one.

- Project File -> Open

Opens a saved project file.

- Project File -> Save

Saves the current project file.

- Project File -> Save as

Saves the present project file under a specified name.

- Program File -> New
Creates a new program file.

-> Window to be used: Program Grid

- Program File -> Open
Opens an existing program file.

-> Window to be used: Program Grid

- Program File -> Save
Saves a created program file.

-> Window to be used: Program Grid

- Program File -> Add
Adds a program to the file pane.

-> Window to be used: Program Grid
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- Program File -> Delete
Deletes a program from the file pane.

-> Window to be used: Program Grid

- Program File -> ReName
Changes the name of a program file.

-> Window to be used: Program Grid

- Program File -> Add Asm
Adds a split file to the tree.

-> Window to be used: Program Grid

- Program File -> Delete Asm
Deletes a split file from the tree.

-> Window to be used: Program Grid

- Program File -> Move On
Moves a split file to the upper tree.

-> Window to be used: Program Grid

- Program File -> Move Under
Moves a split file to the lower tree.

-> Window to be used: Program Grid

- Program File -> Save Flash
Saves a program file in the flash memory of the SV-NET controller.

-> Window to be used: Program Grid

- Log File -> Open
Reads a saved log file and displays it in graphical form.

-> Window to be used: Servo Monitor

- Log File -> Save
Saves the obtained log data in a file.

-> Window to be used: Servo Monitor

- Log File -> Image
Saves the current graph in an image file.
-> Window to be used: Servo Monitor
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- Exit

Exit the SV Programmer.

- Recent File -> Project Name

Selects and opens a recently used project file.
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View

- Ilcon Menu
Toggles the display of the toolbar ON and OFF.
The change is reflected on all target windows.

-> Windows to be used: Device Setup, Controller Setup, JOG Operation, Program Grid, Servo Monitor

- File Explorer
Toggles the display of the supervise tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Tool Explorer
Toggles the display of the toolbar of the currently handled window ON and OFF.

-> Windows to be used: Device Setup, Controller Setup, JOG Operation, Program Grid, Servo Monitor

- Variable List
Toggles the display of the variable list of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Comment
Toggles the display of the comment tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Help
Toggles the display of the help tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Find
Toggles the display of the search tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Output
Toggles the display of the output tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Error List
Toggles the display of the error information tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid
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- Gain
Toggles the display of the gain tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Watch
Toggles the display of the supervise tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Monitor
Toggles the display of the monitor tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Task
Toggles the display of the task tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

-DIO
Toggles the display of the DIO tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

-Jog
Toggles the display of the JOG tab of the Program Grid ON and OFF.

-> Window to be used: Program Grid

- Tool Collapse
Reduces the size of the group box in the tool pane of the currently handled window.

-> Windows to be used: Device Setup, Controller Setup, JOG Operation, Program Grid, Servo Monitor

- Tool Expand
Expands the group box in the tool pane of the currently handled window.

-> Windows to be used: Device Setup, Controller Setup, JOG Operation, Program Grid, Servo Monitor
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Edit

This menu item allows you to edit the program grid.

-Undo

Undoes the last edit.

- Redo

Cancels the last “Undo” operation.

- Copy

Copies the currently selected program steps, variables, and arguments.

-Cut

Cuts the currently selected program steps, variables, and arguments.
- Paste
Pastes the copied or cut data to the currently selected items.

The currently selected items are overwritten.

- Insert Paste

Inserts and pastes the copied or cut program list to the currently selected steps.

- Insert

Inserts blank step lines into the currently selected program step.

Inserts blank lines into the currently selected variable list.

- Delete
Deletes the currently selected program step lines.

Deletes the currently selected variable list lines.
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Debug

This menu item allows you to debug the program grid.

- Program Mode -> Normal / Debug

Changes the program mode.

- Task View

Selects display or non-display of task in debug mode.

- Break Point

Sets a breakpoint in the currently selected program step.

- Break Release

Resets the currently set breakpoints.

- Restart

Restarts the currently stopped program.

- Step In

Executes the currently stopped program step and stops the program before executing the following step.
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Tool

This menu item allows you to execute the content of the tool pane of the currently handled window.

<During Device Setup Operation>

- =¥ Connect to SV-NET Controller

Refer to [Net Search] in the tool pane of the Device Setup window.

[

Read Parameters for All Axes

Refer to [Read All] in the tool pane of the Device Setup window.

- _1'} Read Parameters

Refer to [Read One] in the tool pane of the Device Setup window.

= Write Parameters
Refer to [Write One] in the tool pane of the Device Setup window.

= Parameter File -> Open
Refer to [Open] in the tool pane of the Device Setup window.

. b:‘ Parameter File -> Save

Refer to [Save] in the tool pane of the Device Setup window.

.62 Parameter File -> FLASH Memory Save

Refer to [Flash] in the tool pane of the Device Setup window.

- Display Category
Refer to [Category] in the tool pane of the Device Setup window.

-1 Display List

Refer to [All] in the tool pane of the Device Setup window.

- Switch Parameter Display -> Decimal/hexadecimal

Refer to [Data] in the tool pane of the Device Setup window.
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<During Controller Setup Operation>

- == Connect to SV-NET Controller
Refer to [Net Search] in the tool pane of the Controller Setup window.

: _1|} Read Parameters

Refer to [Read All] in the tool pane of the Controller Setup window.

L Write Parameters

Refer to [Write All] in the tool pane of the Controller Setup window.

47 Open Parameter File -> Open

Refer to [Open] in the tool pane of the Controller Setup window.

: l'.v_-] Parameter File -> Save

Refer to [Save] in the tool pane of the Controller Setup window.

.63 Parameter File -> FLASH Memory Save

Refer to [Flash] in the tool pane of the Controller Setup window.

iz Display Category
Refer to [Category] in the tool pane of the Controller Setup window.

.2 pisplay List
Refer to [All] in the tool pane of the Controller Setup window.

- Switch Parameter Display -> Decimal/hexadecimal

Refer to [Data] in the tool pane of the Controller Setup window.
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<During JOG Operation>

- == Connect to SV-NET Controller
Refer to [Net Search] in the tool pane of the JOG Operation window.

- Operate Servo -> Servo ON

Refer to [SV_ON] in the tool pane of the JOG Operation window.

- Operate Servo -> Servo OFF

Refer to [SV_OFF] in the tool pane of the JOG Operation window.

- F Operate Servo -> Servo FREE

Refer to [SV_FREE] in the tool pane of the JOG Operation window.

- # Operate Servo -> Reset Alarm

Refer to [ALM RST] in the tool pane of the JOG Operation window.

. Display Each Axis
Refer to [Tab] in the tool pane of the JOG Operation window.

-122 Display All Axes
Refer to [All] in the tool pane of the JOG Operation window.
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<During Program Grid Operation>

. 5 Task -> Build
Refer to [Build] in the tool pane of the Program Grid window.

: jl Task -> Download
Refer to [Download] in the tool pane of the Program Grid window.

. [#] Task -> Check
Refer to [Collation] in the tool pane of the Program Grid window.

: ﬂ Task -> Execute Program
Refer to [Start] in the tool pane of the Program Grid window.

: ﬂ Task -> Stop Program
Refer to [Stop] in the tool pane of the Program Grid window.

- ¥ Servo Command -> Servo ON

Refer to [SV_ON] in the tool pane of the Program Grid window.

- ¥ Servo Command -> Servo OFF
Refer to [SV_OFF] in the tool pane of the Program Grid window.

- % Servo Command -> Servo FREE
Refer to [SV_FREE] in the tool pane of the Program Grid window.

- # Servo Command -> Reset Alarm

Refer to [ALM RST] in the tool pane of the Program Grid window.

i Servo Command -> Deceleration Stop

Refer to [Stop] in the tool pane of the Program Grid window.
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<During Servo Monitor Operation>

- =¥ Connect to SV-NET Controller

Refer to [Net Search] in the tool pane of the Servo Monitor window.

ﬂ Execute Program
Refer to [Start] under the “Task” group in the tool pane of the Servo Monitor window.

ﬂ Stop Program
Refer to [Stop] under the “Task” group in the tool pane of the Servo Monitor window.

- Operate Servo -> Servo ON for All Axes

Refer to [SV_ON] in the tool pane of the Servo Monitor window.

- Operate Servo -> Servo OFF for All Axes

Refer to [SV_OFF] in the tool pane of the Servo Monitor window.

- # Operate Servo -> Reset Alarm for All Axes
Refer to [ALM RST] in the tool pane of the Servo Monitor window.

i 3 Operate Servo -> Deceleration Stop

Refer to [Stop] in the tool pane of the Servo Monitor window.

. 4 Operate Log -> Start Log
Refer to [Log Start] in the tool pane of the Servo Monitor window.

- I Operate Log -> Stop Log
Refer to [Log Stop] in the tool pane of the Servo Monitor window.

- ol Operate Log -> Graph

Refer to [View Wave] in the tool pane of the Servo Monitor window.

: YIQ& Operate Log -> X-Y Display
Refer to [View X-Y] in the tool pane of the Servo Monitor window.

: ﬁl Operate Log -> Oscilloscope

Refer to [Oscillo] in the tool pane of the Servo Monitor window.
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: ﬂl Operate Log -> Pause

Refer to [Hold] in the tool pane of the Servo Monitor window.

- Monitor Unit

Refer to [Unit] in the tool pane of the Servo Monitor window.
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Window

This menu item allows you to change the configuration of the currently displayed window.

- Cascade

Cascades windows from the upper left corner.

- Close All Windows

Closes all windows.

- Tile Vertically

Tiles windows vertically.

- Tile Horizontally

Tiles windows horizontally.

- A checkmark is placed next to the window currently in use.

Displays the selected window in the forefront.
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Help

This menu item allows you to display the help menu.

- Contents

Starts the help function to display the contents.

- About SV Programmer

Displays the version of this software.
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Toolbar Functions

This section shows the icons associated with the functions contained in “Tool” of the menu bar.

Device Setup Toolbar

Connectto SVMET Controller Fead Parameters

WWrite Parameters
Read Parameters forAll Axes

Display ListiCategony
o Ty (4 F F Y = DEC -
Open Parameter File FLASH Memaory Save  Switch Parameter Display

Save Parameter File

Controller Setup Toolbar

Connectto SVMET Controller Read Parameters

Fead Parameters far All Axes Switch Parameter Display

= @ | 5 d @) i= | peo -

\ Display List'Catego
Open Parameter File Ry oo

FLASH Memary Save

Save Parameter File
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JOG Operation Toolbar
Cannect to SY-RET Contraller

Servo Ok Semmno OFF

i | S ¥ F
Servo FREE

Display All AxesiEach Axis

ResetAlarm

Program Grid Toolbar (1/2)

Mew Program File

Switch Debug Mode

Qpen Program File Add AS M
Save Pragram File Delete ASMW cut Faste After Line Insertion
Change ASM Marme Copy Faste
Yy L J k
NE H 1Dy e || « ¢ |62 9 O 53 ¥ @ 55 X | Normal -
& &
) ) Lindo
Add Program File to File flowe AS Insert Line Delete Line
Explorer
f LIz rd Redo
Mowve ASM
Drovwrnarard
FLASH Memary Save

Delete Program File from
File Explaorer

Program Grid Toolbar (2/2)
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Display Task Trace

Execute Program

Set Breakpoint
) Stop Program
Feset Breakpoint
Servo ORN Servo OFF
Build
Y 4
O & @ ] i-l 2] i F ¥ ERHA
3 3 3
Festart Program Dovenload Servo FREE
ResetAlarm
Step-in Check
Deceleration Stop
Servo Monitor Toolbar
Connectto SVMET Cantroller StartrStop Logging Dpen Log File
Seno Of Servo OFF Save Program File

LE
e o p

4

StartfStop Task

5 ¥ A

Y

Display Graph
\ FPause Log

o =N = H:j|00mmand

-

k

Chanoe Monitar Unit

Resetalarm  Deceleration Stop

Display =% Graph Save Log Image

Qscilloscope Display

-122 -

Copyright© 2008 Tamagawa Seiki CO.,LTD



Index

ACC/DEC, 47 Description of the Utility Window, 129
Alarm Reset, 67, 80, 118 Details of the Edit Functions, 106
Alarm Status, 69 Device List Display, 18
All View, 14, 38 Device Setup, 10
Argument Check Level, 46 Device Setup Functions, 10
Argument List Grid, 85 Device Setup Information Pane, 16
Array, 86 Display All Axes, 67
Array Variable List, 88 Display Each Axis, 67
Axis Number, 44 Display of Information of Each Axis by Categories, 47
Axis Type, 47 Download, 79
Break, 80 Edit (Menu Bar), 151
Build, 79 Emergency Limit, 45
Category View, 14, 38 Environment, 131
CCW, 67 Error Information Pane, 95
Collation, 79 Exit (Menu Bar), 147
Comment Pane, 90 File (Menu Bar), 145
Connection Information, 16 File Pane, 77
Control Mode, 24 Find Pane, 92
Controller Configuration, 132 Flash, 14, 38, 79
Controller Setup, 34 Form Display Area, 6
Controller Setup Functions, 34 Functions of the SV Programmer, 1
Controller Setup Information Pane, 40 Gain Pane, 96
Controller Type, 7 Grid Pane, 82
Controller Version, 7 Help (Menu Bar), 165
Copy, 79 Help Pane (Controller Setup), 62
Create New Project File (Menu Bar), 145 Help Pane (Device Setup), 33
Cut, 79 Help Pane (Program Grid), 91
Cw, 67 Hold, 117
Debug (Menu Bar), 153 I/O Status, 72, 126
Debug Status, 7 Image, 118
Dec/Hex, 14, 38 Infinity Reset, 49
Delete, 80 Insert, 80
Description of the Controller Setup Window, 36 Insert Paste, 80
Description of the Device Setup Window, 12 JOG Control Pane, 69
Description of the JOG Operation Window, 65 JOG Operation Functions, 63
Description of the Servo Monitor Window, 115 JOG Operation Window, 63
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JOG Pane, 104
Label Setup, 142

List of All Parameters Including Writable Parameters, 20

List of Parameters, 60

Log Start, 117

Log Stop, 117

MAC-ID Tab Category Click, 23
Main Form, 5

Main Toolbar, 5

MCH Configuration, 44

MCH Information Tab Page, 44
MCH Status, 72

MCH Type / Max Axis, 44
Mechanism/IO Monitor Pane, 72
Memory Switch Information, 41
Menu Bar Functions, 145
Menu Configuration, 145
Mode, 70

Monitor Function, 110

Monitor Pane, 100

Motor Type, 47

Negative Hard Limit, 50
Negative Soft Limit, 49

Net Search, 14, 38, 67, 117
New, 79

Normal, 80

Open Log Data, 118

Open Parameter File, 14, 38
Open Program File, 79

Open Project File (Menu Bar), 145
Operations Disabled in Debug Mode, 109

Oscillo, 117

Output Pane, 94
Override, 7, 67, 79
Parameter Writing, 138
Paste, 79

Positive Hard Limit, 50
Positive Soft Limit, 49
Preview, 14, 38

Print, 14, 38

Profile Data, 30

Program File Menu, 77

Program Grid Functions, 74
Program Grid Window, 74

Program Step Grid, 83

Program Writing, 139

Progress Bar, 8

Project File Selection Box, 9

Read All, 14, 38

Read One, 14

Ready Alarm Status, 7

Recent File (Menu Bar), 147

Redo, 79

Release, 80

ReStart, 80

Restrictions on Variable Names, 86
RS232C Auto Communication Setting, 58
RS232C Basic Setup, 56

Save Log Data, 118

Save Parameter File, 14, 38

Save Program File, 79

Save Project File (Menu Bar), 145
Save Project File with Name (Menu Bar), 145
Selecting a language, 131

Servo Command, 26

Servo feedback, 120

Servo Feedback, 69

Servo FeedBack, 24

Servo Free, 67, 80

Servo Gain, 31

Servo Monitor, 113

Servo Monitor Functions, 113
Servo Monitor Pane, 120

Servo OFF, 67, 80, 118

Servo ON, 67, 80, 118

Servo status, 120

Servo Status, 28, 69

Setting the Device Setup Window, 133
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Setting the Program Grid Window, 136 Tool (Menu Bar), 154

Setting the SVC Setup Window, 135 Tool Button, 70
Shortcut Keys, 112 Tool Pane (Controller Setup), 38
Smooth Stop, 80, 118 Tool Pane (Device Setup), 14
Software Operating Environment, 2 Tool Pane (JOG Operation), 67
Speed Level, 69 Tool Pane (Program Grid), 79
Speed Limit, 48 Tool Pane (Servo Monitor), 117

Split File Menu, 77 Toolbar Functions (Menu Bar), 166

Start, 79, 117

Starting Home Mode, 45
Starting the SV Programmer, 4
Status Bar, 7

Undo, 79
Unit, 117
USB Status, 7
Utilities, 128

Step In, 81 Utility Functions, 128
Stop, 79, 117 Variable, 86
Subpane, 90 Variable List Grid, 86

SV-NET Baudrate, 42

SV-NET Controller Product Information, 40
SV-NET Driver Information, 23

System Information, 40

Task Pane, 101

Task Status, 7

Task View, 80

The icon menu is diplayed at all times, 131
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View Wave, 117

View X-Y, 117

Watch Pane, 98
Window (Menu Bar), 163
Write All, 38

Write One, 14
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